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C H A P T E R
1 Introduction
This chapter presents an overview and the system 
requirements for the SLM Utility-G3 software.

Overview

Larson Davis SLM Utility-G3 Software works in
conjunction with both the Larson Davis Model 831 and the
SoundTrack LxT. However, some of the functionality
described in this manual is not supported in SoundTrack
LxT.

This manual can be used with the
Model 831 Manual (I831.01) and the
SoundTrack LxT Manual (I770.01),
which provide complete
specifications and instructions for
the operation of these instruments. 

The SLM Utility-G3 Software enhances the flexibility and
ease-of-use of the Model 831 and SoundTrack LxT by
providing setup utilities, instrument calibration, computer-
based control of the instrument, data downloading, printing,
and export of data to third party software for post processing
and analysis.

System Requirements

Minimum Recommended
Operating System Windows XP Pro with 

(SP3), Windows Vista 
Business, Windows 7

Windows 7 Pro

Computer Processor 1 GHz 2 GHz
Computer Memory 2 GB 4 GB
Available Hard Disk Space 100 MB 100 MB
Screen Resolution 1024 X 768 1280 X 1024
CD Drive Yes Yes
USB Connection Yes Yes
Microsoft Office Office 20031 Office 20102

Broadband Internet Required for Remote Internet and Wireless connections.
Analog Modem Required for Remote Modem connections.
1 Required for export to Excel
2Required for export to Excel with full FFT support.
SLM Utility-G3 Manual Introduction 1-1



1-2 System Requirements SLM Utility-G3 Manual



C H A P T E R
2 Getting Started
This chapter presents the information for installing, con-
figuring, and using the SLM Utility-G3 software.

Installing the SLM Utility-G3 Software

Install SLM Utility-G3 prior to
connecting a sound level meter.

When you insert the SLM Utility-G3 CD, it will start
automatically. If it does not, access the CD drive and click
setup.exe.

The install program installs the program files and prompts
for any additional required information. A PCB
Piezotronics menu item will be created under the Program
menu item in the Start menu.

Configuring the USB Port (Windows XP)

The New Hardware Wizard, as shown in FIGURE 2-1,
appears when an instrument is connected to a USB port.

FIGURE 2-1  Found New Hardware Dialog Box
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When the dialog box appears, click “No, not this time” and
then click Next to obtain the display shown in  FIGURE 2-2.

FIGURE 2-2  Automatic Installation

Click the radio button for “Install the Software automatically
and click Next to continue. 

Upgrading Software to Version 2.0

Prior to version 2.0 of the SLM Utility-G3 software, the
saved settings files, calibration history log files, and certain
internal data files were created and saved in C:\Program
Files\PCB Piezotronics\Slm Utility-G3. However, with the
release of Windows Vista and Windows 7, this folder is now
a restricted folder that requires administrator privileges for
write access. Beginning with version 2.0, these files are now
created and saved in one of the following locations, based on
your OS. 

In these example paths, the folder
marked with an * is a hidden folder
by default. To see this folder, enable
the ‘Show hidden files and folders’
option on the View tab of the Folder
Options dialog in Windows.

Windows XP: C:\Documents and Settings\All Users\Application
Data*\PCB Piezotronics\Slm Utility-G3.

Windows Vista: C:\Users\AllUsers*\PCB Piezotronics\Slm
Utility-G3.

Windows 7: C:\ProgramData*\PCB Piezotronics\Slm Utility-G3.
2-2 Configuring the USB Port (Windows XP) SLM Utility-G3 Manual



If the user attempts to connect with
the instrument before it has
completed its boot sequence, the
connection will fail and the
instrument may lock up.

When Slm Utility-G3 v2.0 or later makes a connection to a
meter for the first time, a scan of the application folder is
performed looking for any legacy settings files (i.e.
831setup.dat, SLMPreference.dat) and any existing
calibration history log file entries for the meter being
connected. Any legacy data found is then merged into the
new files created in the folder described above.

SLM Utility-G3 Main Window

Only a single instance of SLM
Utility-G3 can be run at a time.

When the SLM Utility-G3 Software is fully loaded, the
SLM Utility-G3 Main window is displayed as shown in 
FIGURE 2-3.

FIGURE 2-3  SLM Utility-G3 Main Menu

Menu Bar

Toolbar
SLM Utility-G3
SLM Utility-G3 Manual SLM Utility-G3 Main Window 2-3



Menu Bar

The Menu Bar, a standard Windows feature, contains the
following four drop-down menus, which are opened by
clicking the title.

•File

In addition to standard Windows features, the File Menu
also includes an item permitting the user to upgrade an
instrument without opening the Instrument Manager, as
shown in  FIGURE 2-4.

FIGURE 2-4  File Menu

•Connection

•View

•Help

Although most of the SLM Utility-G3 operations can be
performed using icons in the SLM Utility-G3 Toolbar, all
functions can be performed by selecting one of the options
listed on one of these menus as described in this manual.

Help/About 

Click the Help Menu to obtain a single item, “About SLM
Utility-G3. Click that to display the About window, which
provides a list of the software components loaded and their
version numbers.

Upgrade
Instrument
2-4 SLM Utility-G3 Main Window SLM Utility-G3 Manual



SLM Utility-G3 Toolbar

Just below the menu bar is the toolbar as shown in  FIGURE
2-5. 

FIGURE 2-5  Toolbar

The tool bar provides quick access to commonly used
software functions. A description of the function of each
toolbar button, or icon, is presented in Table 2-1 below.

The Connect button will make the connection to the
instrument connected to the computer.

The Disconnect button will terminate the connection
between SLM Utility-G3 and the instrument
connected to the computer.

The Open File button will bring up a standard
windows browse window that will allow the user to
open an existing database record.

The Save File button will bring up a standard
windows save file dialog box, that will allow the
user to save the current SLM Utility-G3 file. The
dialog window will also allow the user to select a
file name and location.

The Instrument Manager button will bring up the
Instrument manager screen. The user can then setup
the instrument, set the clock, download data files,
etc.

The Measurement Log button will display the
measurement log.

The Print button will print the currently displayed
record. 

Table 2-1 SLM Utility-G3 Toolbar Buttons
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SLM Utility-G3 Session Log

On the left side of the screen you will find the SLM Utility-
G3 Session Log.

FIGURE 2-6  SLM Utility-G3 Session Log

This useful area provides information with respect to the
status of an active (connected) instrument, providing the
following information: 

• If the PC is currently connected to an instrument

• Whether the connected instrument is running, stopped,
reset, locked or unlocked

• The serial number of the instrument

• If data has been downloaded from the instrument

• If the unit has been calibrated

The SLM Utility-G3 Session Log will be automatically
updated when any of these operations has occurred.

Close/Open Session Log, Measurement Log and Instrument Manager

The Open/Closed status of the Session Log, Measurement
Log and Instrument Manager can be changed by clicking
View from the Main Menu, which will open the menu
shown in  FIGURE 2-7.

The Export Data button will export the currently
displayed record as an Excel spreadsheet, a Comma-
Delimited File that can be opened in a spreadsheet
application or as a text file. It will also allow the
user to select the output location and file name, and
whether or not to automatically launch the viewer
application.

The About button will bring up the SLM Utility-G3
About screen with the current revision number.

Table 2-1 SLM Utility-G3 Toolbar Buttons
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FIGURE 2-7  View Menu

A check in front of an item indicates that it is already being
displayed; clicking it will close it. Clicking an unchecked
item will open it and place a check in front of that item.

Connecting to an Instrument

Making the Connection

To connect to an instrument, click the Connect icon on the
toolbar as shown in  FIGURE 2-8, or select

 

FIGURE 2-8  Toolbar: Connect

Connection->Direct->USB from the Main Menu as shown
in  FIGURE 2-9.

FIGURE 2-9  Connection/Direct

Single Instrument Connected to Computer

If only a single instrument is connected to the computer via
USB, the connection to that instrument is initiated
automatically.
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Multiple Instruments Connected to Computer

When more than one instrument is physically connected to
the computer via USB, the dialog shown in  FIGURE 2-10
will be displayed.

FIGURE 2-10  Physically Connected Instruments

Click the down arrow next to the data field to list the
connected instruments by model and serial number as shown
in  FIGURE 2-11.

FIGURE 2-11  List of Physically Connected Instruments

In this instance, there are two instruments connected, a
Model 831 and a SoundTrack LxT. 

In this manual the displays will
correspond to those obtained when
the connected instrument is a Model
831 unless specifically noted.

Select the desired instrument to connect to and click the
Connect button to initiate the connection.
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Multiple Instruments, Changing Instruments

You must close the Instrument
Manager before you can click on any
toolbar button or menu. 

When connected to one of multiple instruments connected to
the computer via USB, to change the connection to a
different instrument, click Connection/Change
Instrument, which will open the “Connect to Selected
Instrument” menu shown in  FIGURE 2-10. Use this menu
and proceed as described to select the new instrument with
which to make the connection.

Interface Active Message

If the instrument is in the Measurement Setup, Preferences
or Calibration modes at the time the connection operation is
initiated, the message shown in  FIGURE 2-12 will be
displayed.

FIGURE 2-12  Interface Active Message

Click Yes to continue the connection or press No to abort the
connection operation and manually save the setup in the
instrument. Clicking Yes may cause the loss of setting
changes when the user closes the instrument’s user interface.

Disconnecting the Instrument

To disconnect the instrument from the software, click the
Disconnect icon from the toolbar as shown in  FIGURE 2-
13.

FIGURE 2-13  Toolbar: Disconnect
SLM Utility-G3 Manual SLM Utility-G3 Main Window 2-9



Reconnecting the Instrument

After disconnecting from the instrument, clicking the
connect icon, as shown in  FIGURE 2-8, will reconnect the
software to the same instrument to which it had been
connected prior to disconnecting. 

If there are multiple instruments connected to the computer
via USB ports and you wish to connect to a different
instrument than the one to which it had been connected prior
to the disconnect, select Connection->Direct->USB from the
Main Menu as shown in  FIGURE 2-9. Continue to select
the desired instrument as described in the "Multiple
Instruments Connected to Computer" on page 2-8.
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C H A P T E R
3  Instrument Manager
This chapter presents information for the features and 
options of the Instrument Manager.

Overview

Most of the operations of the SLM Utility-G3 Software are
controlled from the Instrument Manager. Specific features
implemented from the Instrument Manager include the
following:

This chapter describes the
Instrument Manager for SLM mode.
Please refer to Chapter 7 for RT-60
mode specific changes and to
Chapter 8 for FFT mode specific
changes.

•  Determination of instrument status; serial number,
firmware version, battery status, data records in
memory and date/time.

•  Management of instrument setups, including creation,
modification and deletion of setups and utilization of the
Setup Manager to work with the setup database.

•  Manual control of the instrument via the PC.

Setup tabs displayed on the
SoundTrack LxT may in some cases
appear differently than those on the
Model 831 and may also present a
smaller set of parameters. In this
manual, setup tabs may be presented
separately by instrument, or where
similar, represented simply by the
Model 831 tabs.

•  Downloading of data from the instrument to the PC

•  System calibration 

•  Defining user preferences 
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Opening the Instrument Manager

To view the instrument manager
window an instrument must be
connected, as described in the
section "Connecting to an
Instrument" on page 2-7. If you
inadvertently close the Instrument
Manager window, you can re-open it
by clicking the Instrument Manager
icon on the toolbar.

The Instrument Manager is automatically displayed when
Slm Utility-G3 has successfully connected to an instrument.
It is comprised of six tabs. When the Instrument Manager is
first opened, the Instrument Status tab will be displayed as
shown in  FIGURE 3-2.

The Session Log will indicate the date and time the
connection was established, as shown in  FIGURE 3-1.

FIGURE 3-1  Session Log: Connected

FIGURE 3-2  Instrument Manager: Instrument Status

Instrument Status Tab

To display the Instrument Status tab, click on the
Instrument Status tab of the Instrument Manager. The
Instrument Status tab, as shown in  FIGURE 3-2, displays
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the Model, Serial Number, Firmware Version, Power usage,
amount of Free Memory, number of Records (data files),
Instrument Time, and Computer Time. The Power, Free
Memory, and Records fields may be refreshed at any time by
clicking the Refresh button. The Instrument Time and
Computer Time are updated automatically every second.

Setting the Date and Time

To set the date and time on the instrument, clickthe Set Time
button, as shown in  FIGURE 3-2. This will display the
Instrument Date and Time dialog box, as shown in 
FIGURE 3-3.

The System Preferences option sets
the synchronization of date and time
with the PC. See "Synchronize date/
time with PC" on page 3-78.

FIGURE 3-3  Instrument Date and Time: Manual

There are two formats available for
date. See "Date Format" on page 3-
78 for further detail.

Manually Setting the Date and Time

When “Sync. date/time” with PC is not selected, the date
and time in the instrument can be set manually. Clicking the
down arrow to the right of the Instrument Date field will
open the Instrument date calender shown in  FIGURE 3-4.

FIGURE 3-4  Date Calender
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Click the left or right arrow keys at the top to bring up the
desired month and year, then click the desired day to
complete input of the date.

In the Instrument Time field, the hours, minutes and seconds
are selected separately, highlighting each and using the up
and down arrow keys to the right of the data field to select
the desired values. Clicking the Set button will set the Date
and Time on the instrument to the selected values.

Synchronizing the Instrument Date and Time with 
the PC

To synchronize the date and time between the instrument
and the PC, ensure the "Sync. date/time with PC" check box
is checked as shown in  FIGURE 3-5 and press the Set
button. This will set the date and time on the instrument to
the same date and time as on the PC.

FIGURE 3-5  Instrument Date and Time: 
Synchronized
3-4 Instrument Status Tab SLM Utility-G3 Manual



Settings Tab

For a detailed description of the
settings defined on the various
Settings sub-pages, refer to the
applicable sound level meter
manual.

To display the Settings tab, click on the Settings tab of the
Instrument Manager.

The Settings tab is comprised of nine sub-tabs as shown in 
FIGURE 3-6. Each sub-tab can be accessed by clicking on
the appropriate sub-tab on the Settings tab. Sub-tabs that are
currently out of view can be scrolled to by using the left/
right arrow buttons at the far right. The Settings tab also
provides access to the Setup Manager, which is described
under "Setup Manager" on page 3-34.

FIGURE 3-6  Instrument Manager: Settings
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Displaying the Instrument’s Setup

When the Settings tab is selected for the first time, the setup
currently active on the instrument will be downloaded and
displayed on the appropriate sub-tabs. The Setup Manager
drop-down will show "<Instrument Settings>" to indicate
that the displayed values are what is currently set on the
instrument. The user may refresh the displayed values (or
undo any changes made) by clicking on the Setup Manager
drop-down and selecting "<Instrument Settings>".

Displaying the Settings

The settings are distributed over nine sub-tabs. Each sub-tab
is accessed by clicking the appropriate tab and will display
the settings as shown in the following figures:

General

The General sub-tab provides access to the Default Data File
Name and Measurement Description settings as shown in 
FIGURE 3-7.

FIGURE 3-7  Settings: General
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Measurement

The Measurement sub-tab provides access to the settings
shown in  FIGURE 3-8.

FIGURE 3-8  Settings: Measurement
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Dosimeter

The Dosimeter sub-tab, shown in  FIGURE 3-9, provides
access to settings that define noise exposure level, duration,
and threshold to comply with health and safety regulations.

FIGURE 3-9  Settings: Dosimeter

Auto-Calculate

The Criterion Level and Criterion Duration can be set
independently. However, the standards define a linear
relationship between level and duration. When Auto-
Calculate is selected, (by checking the Auto-Calculate check
box) only one of these values needs to be entered and the
other one will automatically be set to follow the standard.

Load Std. Criteria 

The user can populate the Dosimeter settings from a pre-
defined set of Standard Criteria by clicking the Load Std.
Criteria button. This will display the Standard Dose Criteria
dialog as shown in Figure 3-10. Highlight the desired
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Standard and click OK to make the change, or press Cancel
to keep the current settings.

FIGURE 3-10  Standard Dose Criteria

Measurement Control

The Measurement Control sub-tab, shown in  FIGURE 3-11,
provides access to settings related to how and when the
instrument will RUN, STOP and/or STORE a measurement.
The actual settings available will depend upon the Run
Mode selected, consistent with the different types of data
acquisition permitted.

FIGURE 3-11  Settings: Measurement Control
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Time History (Model 831)

For time Periods less than 20 ms,
please refer to "Time History (Model
831): FST" on page 3-12

The settings available and displayed on the Time History
sub-tab will vary based on the Period selected, installed
options, and the value of certain settings that are set on other
sub-tabs. The Time History sub-tab, as shown in  FIGURE
3-12, represents all the settings available when a Period of
100 ms or slower is selected.

FIGURE 3-12  Settings: Time History (Model 831)

LTWA and Lmax/Lmin

The LTWA and all Lmax/Lmin options will be disabled
(greyed out) when the Period is 50 ms or faster.

Ln Statistics 

The Ln Statistics setting will be disabled when the Period is
faster than 500 ms.

OBA Spectra

The OBA Spectra group will be hidden if the optional
firmware 831-OB3 has not been installed. The settings will
be enabled/disabled based on the OBA Bandwidth setting on
the Measurement sub-tab.
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LAFTM5

The LAFTM5 setting will only be enabled when the Period
is set to 5 s or slower and the "Takt Maximal Data" setting is
checked on the System->Preferences sup-tab.

Advance Settings

The Weather settings will be
disabled if the Weather setting on the
Weather sub-tab is set to None. Also,
the Preamp settings will only be
enabled when a 426A12 or
PRM2103 is attached to the
instrument.

In addition to the acoustic settings, a number of non-acoustic
and system settings can also be saved in a time history record.
To access these additional settings, click the Advanced button
on the Time History sub-tab to display the Advanced Time
History dialog as shown in  FIGURE 3-13.

FIGURE 3-13  Advanced Time History

Check the box for each non-acoustic setting to be included
in the time history record and click OK when done.
SLM Utility-G3 Manual Settings Tab 3-11



Time History (Model 831): FST

When a Fast (FST) Time History Period of 10, 5, or 2.5
ms is selected (only available when the optional firmware
831-FST is installed), the Time History sub-tab will
appear as shown in  FIGURE 3-14.

FIGURE 3-14  Settings: Time History (Model 831): FST

Enabling this option will greatly
increase the amount of memory used.

When selecting one of the Fast Time History periods (10, 5,
2.5 ms), the following settings will be disabled:

•  Measurement History

•  Event History

•  Sound Recording

•  Spectral Ln
3-12 Settings Tab SLM Utility-G3 Manual



Also, the OBA Spectra settings will be limited to an Leq in
either 1/1 or 1/3 octave (not both) and all non-acoustic
settings, except Tms (millisecond accuracy), will be
disabled as shown in  FIGURE 3-15. 

FIGURE 3-15  Advanced Time History: FST
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Time History (SoundTrack LxT)

When connected to a SoundTrack LxT, the Time History
sub-tab will appear as shown in  FIGURE 3-16.

FIGURE 3-16  Settings: Time History (SoundTrack LxT)
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Events (Model 831)

The Events sub-tab, shown in  FIGURE 3-17, provides
access to settings related to noise exceedance events and
trigger levels.

FIGURE 3-17  Settings: Events (Model 831)
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Events (SoundTrack LxT)

When connected to a SoundTrack LxT, the Events sub-tab
will appear as shown in  FIGURE 3-18.

FIGURE 3-18  Settings: Events (SoundTrack LxT)
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Markers

The Markers sub-tab, shown in  FIGURE 3-19, provides
access to settings related to pre-defined markers.

FIGURE 3-19  Settings: Markers
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Miscellaneous (Model 831)

The Miscellaneous sub-tab, shown in  FIGURE 3-20,
provides access to settings defining the start times for Day,
Evening, and Night time periods and associated noise
penalties, as well as Sound Recording settings that did not fit
elsewhere.

FIGURE 3-20  Settings: Miscellaneous (Model 831)
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Miscellaneous (SoundTrack LxT)

When Connected to a SoundTrack LxT, the Miscellaneous
sub-tab will appear as shown in  FIGURE 3-21.

FIGURE 3-21  Settings: Miscellaneous (SoundTrack LxT)
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Weather (Model 831 Only)

The Weather sub-tab provides access to optional Weather
settings. The actual settings available will depend upon the
Weather setting selected. The settings for Vaisala are shown
in  FIGURE 3-22.

FIGURE 3-22  Settings: Weather

Creating a New Setup

Setups which have been created and
stored previously can be recalled,
and modified if necessary, instead of
creating new ones. For more details
on recalling a setup, see “Recalling
a Setup” on page 3-33.

All of the settings on the various sub-tabs of the Settings tab
are collectively referred to as a Setup. The user can make
any desired changes to the settings and save that
configuration in a Setup file. This allows the user to recall a
particular settings configuration to upload to an instrument
after a Format/Restore Defaults or to upload to multiple
instruments.

General Settings

The Default Data File Name and Measurement Description
settings are available on the General sub-tab as shown in 
FIGURE 3-7.
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Measurement Settings

For a detailed description of the
settings defined on this tab, refer to
the instrument’s user manual.

The settings available on the Measurement sub-tab define
some basic sound level parameters such as Frequency and
Peak Weighting, Detector type, Integration Method, Ln
percentages, as well as OBA (Octave Band Analyzer)
settings such as Range, Bandwidth, Weighting, and
Spectrum as shown in  FIGURE 3-8.

Octave Band Data

Note that the OBA settings will only be available if the
appropriate optional firmware has been installed:

•  Model 831: 831-OB3 (1/1 and 1/3 octaves)

•  SoundTrack LxT: LxT-OB1 (1/1 octave only) or LxT-
OB3 (1/1 and 1/3 octaves)

Dosimeter Settings

In order to measure noise dose, the
Model 831 must have the optional
firmware 831-IH loaded. This
functionality is standard with the
SoundTrack LxT.

The settings defining the measurement of noise dose are set
from the Dosimeter sub-tab, shown in  FIGURE 3-9.

Predefined Setups

The Dosimeter settings can be loaded from a set of
Standards based pre-defined criteria by clicking the Load
Std. Criteria button which will display the Standard Dose
Criteria dialog as shown in  FIGURE 3-10. Simply highlight
the desired Standard and click OK to automatically populate
the settings.

Measurement Control Settings

For a detailed description of the
measurement control settings, with
and without time history, refer to the
instrument’s user manual.

The settings available on the Measurement Control sub-tab,
as shown in  FIGURE 3-11, will define how and when the
instrument will RUN, STOP and/or STORE data when
taking a measurement and if a Measurement History will be
kept. Most of the settings on this tab are shown/hidden and/
or enabled/disabled based primarily on the Run Mode
setting and the Enable Measurement History setting.

Measurement History

If an FST Period is selected on the
Time History sub-tab, the Enable
Measurement History setting will be
disabled.

The Enable Measurement History setting determines if a
measurement history will be saved and stored with each
Measurement. Of the remaining settings on this sub-tab,
only "Interval Time Sync." and "Interval Time" are
dependent on this setting.
SLM Utility-G3 Manual Settings Tab 3-21



Run Mode

The Select Run Mode setting determines how and when the
instrument will Run, Stop, and Store data and can be one of
the following:

•  Manual Stop

•  Timed Stop

•  Stop When Stable

•  Continuous

•  Single Block Timer

•  Daily Timer

Click on the Run Mode drop-down to select the desired
mode as shown in  FIGURE 3-23. The remaining settings
available on this sub-tab will be determined by the Run
Mode selected.

FIGURE 3-23  Select Run Mode

Manual Stop

In Manual Stop mode, the instrument will never
automatically Run, Stop, or Store a measurement. To take a
measurement, the user must manipulate the appropriate keys
on the keypad, either physically or via ScreenGrabber, to
Run, Stop, and/or Store a measurement.

Enable Measurement History is the only other setting
available when in this mode.
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Timed Stop

In Timed Stop mode, the instrument will automatically stop
and store at least one record each time the instrument is Run
as shown in  FIGURE 3-24.

FIGURE 3-24  Timed Stop

To enable the Measurement Counter
setting, the Measurement Time
setting must be set to at least 1
minute.

The duration of each record is determined by the
Measurement Time setting and the number of records
created (of Measurement Time duration) is determined by
the Measurement Counter setting. The user must still
manually start the measurement.

As an example, using the settings shown in  FIGURE 3-24,
after the user presses Run, the instrument will create 10
measurement records with each record having a duration of
1:20 and then Stop.

Stop When Stable

In Stop When Stable mode, the instrument will continue to
run until the measured level remains within a defined
amplitude range for a defined duration of time, as shown in 
FIGURE 3-25.

FIGURE 3-25  Stop When Stable
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The Delta setting determines the amplitude range and the
Time setting determines the time duration requirement. The
user must still manually start the measurement.

As an example, using the settings shown in  FIGURE 3-25,
after the user presses Run, the instrument will continue to
run until the measured level stays within a .2 dB range for 20
seconds and then Stop.

Continuous

In Continuous mode, the instrument will continue to run
until the user presses Stop or the instrument exceeds its
storage capacity. Several settings are enabled which will
determine the time interval for each measurement history,
provide a means of automatically storing data, and allow for
a daily calibration check as shown in  FIGURE 3-26.

FIGURE 3-26  Continuous

If the Enable Measurement History setting is checked, the
Interval Time setting will determine the duration of each
measurement history record. The minimum duration is 1
minute. The Interval Time Sync. setting, if checked, will
ensure that each measurement history record, after the first,
will begin at a time that is a multiple of the Interval Time
setting. For example, using the settings shown in Figure 3-
26, a measurement started at 08:13:23 would end at
08:15:00 so that the next and subsequent measurements
could start at an even multiple of 5 minutes (i.e 08:15:00,
08:20:00, 08:25:00, etc...). The Interval Time Sync. and
Interval Time settings are disabled if the Enable
Measurement History setting is not checked.

The Daily Auto-Store setting allows for the automatic
storing of data at equal time intervals within a 24-hour time
period, beginning at a user specified time. For example,
using the settings shown in  FIGURE 3-26, a new data file
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would be stored every 2 hours (12/day), beginning at 1 AM
(01:00:00). The associated Time setting determines the start
of the 24-hour time period. If the Daily Auto-Store setting is
set to Never, the associated Time setting is disabled and no
automatic storage will occur.

The Daily Cal-Check setting will allow for an instrument
equipped with a Model 426A12 Outdoor Preamplifier to
perform a daily calibration check at a time specified by the
associated Time setting.

Single Block Timer 

In Single Block Timer mode, the user can specify a block of
time during which a measurement is to be run. The
instrument will begin a measurement at the specified Start
Time setting and end the measurement at the specified End
Time setting. This will occur every day beginning on the
date specified in the Start Date setting with the last
measurement occurring on the date specified in the End Date
setting. 

For example, using the settings shown in  FIGURE 3-27, the
instrument will begin a measurement at 1 am and end the
measurement at 3 am every day beginning on March 1st,
2011 and ending on March 31st, 2011.

FIGURE 3-27  Single Block Timer

Daily Timer

Daily Timer mode is similar to Single Block Timer mode but
allows the user to specify up to three, non-overlapping,
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blocks of time during which a measurement is to be run.
Selecting the One Time Block setting is functionally
identical to Single Block Timer mode while selecting either
the Two Timed Blocks or the Three Timed Blocks setting
will allow for either two or three time blocks, respectively. 

The Start Time and End Time settings for each block should
not overlap. Also, the earliest start time should be defined in
the Start Time 1 setting and the latest start time should be
defined in the Start Time setting of the last time block
specified as shown in  FIGURE 3-28.

FIGURE 3-28  Daily Timer

Daily Timer Example

As an example, lets say Bob has been asked by the city
council to take sound level readings near a busy intersection,
during rush hour, every day, for a month. There are also
several Bars in the area so Bob has been asked to also take
readings between 23:30 and 03:00 (Bars close at 01:00).

So Bob connects to his instrument using Slm Utility-G3 and
configures the Measurement Control settings as shown in 
FIGURE 3-28. Bob then places his instrument in the field on
the last day of February. 
3-26 Settings Tab SLM Utility-G3 Manual



Beginning on March 1st, the instrument will take three
measurements every day until March 31st. The first
measurement will start at 05:00 and stop at 09:00, the
second measurement will start at 15:30 and stop at 19:30,
and the third measurement will start at 23:30 and stop at
03:00 of the next day. The last measurement taken will start
at 23:30 on March 31st and end at 03:00 on April 1st.

Time History Settings

The settings that define the measurement of time history
data are set on the Time History sub-tab, shown in  FIGURE
3-12.

OBA Spectra

OBA Spectra settings require the appropriate optional
firmware be installed on the instrument.

•  Model 831: 831-OB3 (1/1 and 1/3 octave bands)

•  SoundTrack LxT: LxT-OB1 (1/1 octave only) or
LxT-OB3 (1/1 and 1/3 octaves)

Also, the OBA Bandwidth setting on the Measurement sub-
tab must not be set to Off.

Event Settings (Model 831 Only)

The settings that define the measurement of noise
exceedance events are set on the Events sup-tab (see 
FIGURE 3-17). Note that several optional firmware
packages are required to be installed in the Model 831 for all
settings to be available.

Event History

Event History settings require the optional firmware 831-
ELA be installed.

Event Time History

In addition to the above, Event Time History settings require
the optional firmware 831-LOG be installed. 

Spectral Mode

In addition to all of the above, Spectral Mode settings
require the optional firmware 831-OB3 be installed.

Marker Settings

The settings that define the marker data are set on the
Markers sub-tab, shown in  FIGURE 3-19. 
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Audio Recording is only available on
the Model 831 when the optional
firmware 831-SR is installed.

To automatically initiate an audio recording whenever a
specific Marker is set by the user, click to place a check
mark in the Record Sound check box for that Marker. 

The Pre-marker Time setting allows for up to 9 seconds of
recorded data prior to the Marker event be include in the
Marker recording. The Record Time setting is how many
seconds to record after the Marker event with a maximum
setting of 9999 seconds.

Miscellaneous Settings

The Miscellaneous sub-tab, as shown in  FIGURE 3-20,
provides access to settings that do not fit elsewhere.

Ldn and Lden

Ldn and Lden require the optional
firmware 831-ELA or LxT-CN.

The settings in the Ldn and Lden section are used to define
the Start Time settings for the Day, Evening, and Night
periods (used in the calculation of Lden) as well as the
Evening Penalty and Night Penalty settings applied to noise
levels measured during the associated time period.

Sound Recording (Model 831 Only)

Sound Recording requires the
optional firmware 831-SR be
installed on Model 831.

The settings defined in the Sound Recording section are
used for all Sound Recordings made on the instrument
(Event Sound Snapshots, Marker Recordings, and
Measurement Sound Snapshots).

Sound Snapshot (Model 831 Only)

Sound Snapshot requires the
optional firmware 831-SR and 831-
ELA be installed on the Model 831.

The Sound Snapshot section provides access to the Sound
Snapshot settings for Measurement History records. The
Enable setting, if checked, will store a Sound Snapshot (of a
duration defined by the Time setting) at the start of each
measurement (or interval) record. The Time setting defines
the duration of the Sound Snapshot and can be any value
between 1 and 9999 seconds.
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Weather Settings

The Weather sub-tab provides access to various Weather
settings based on the choice made in the Weather drop-down
setting as shown in Figure 3-29. If the Weather setting is set
to None, no other settings will be available.

FIGURE 3-29  Weather Setting

Weather-INT Settings (831-INT)

When the Weather setting is set to Weather-INT, the Weather
sub-tab will appear as shown in  FIGURE 3-30.

FIGURE 3-30  Weather-INT Settings

The correct values to use for the various Scale, Units, and
Offset settings are dependent on the type of sensor and/or
transducer attached to the 831-INT. Please refer to the
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instrument manual for a complete description of these
settings.

Wind Settings

The Direction setting can be set to one of Compass, Degrees,
Percent, or Volts and governs in which format the direction
will be displayed. When set to Compass, the direction is
displayed as one of eight compass points (N, NE, E, SE, S,
SW, W, NW). Otherwise, it is displayed as a numerical value
in the specified format.

The Threshold setting is used to set the 'Windy' threshold.
Wind speeds above this setting will be considered 'Windy'.

The Excd. Pause setting can be either Yes or No and
determines whether or not to pause data sampling when
wind speed exceeds the Excd. Level setting. When set to
Yes, Exceedance sampling will be paused until the wind
speed falls below the Excd. Level setting minus the
Hysteresis setting. When set to No, Exceedance sampling
will not be paused.

The Excd. Level setting determines the wind speed level at
which Exceedance sampling will be paused.

The Hysteresis setting determines how far below the Excd.
Level setting the wind speed must drop before Exceedance
sampling is resumed after being paused.

ADC1 & ADC2 Settings

The 831-INT has two analog/digital converter inputs used to
obtain temperature and humidity data from external
transducers. The ADC1 and ADC2 settings have therefore
been predefined for Temperature and Humidity settings,
respectively. However, since other types of transducers can
be connected to these ports, the Description, Scale, Offset,
and Units settings can be set to appropriate values for the
transducer(s) being used.
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Vaisala Settings

When the Weather setting is set to Vaisala, the Weather sub-
tab will appear as shown in  FIGURE 3-31.

FIGURE 3-31  Vaisala Settings

Vaisala does not allow the Units settings to be edited, but the
displayed units will change between English and SI based on
the Units setting on the System tab, Preferences sub-tab as
shown in  FIGURE 3-99.

The Direction setting for Vaisala is limited to Compass and
Degrees. Otherwise, all settings are the same as described
under Weather-INT.
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Uploading a Setup to the Instrument

Uploading settings or preferences
from SLM Utility-G3 to the
instrument will disable some settings
if the associated option is not
installed on the instrument. For
example, if a preference file which
turns on RS232 communications is
uploaded to an instrument which
does not have the communications
option installed, those settings will
be ignored.

To upload new settings to the instrument, click the Upload
Settings button at the bottom of the Settings tab as shown in 
FIGURE 3-6.

Saving a Setup

As stated previously, all instrument settings are collectively
referred to as a Setup. To save a Setup to the Stored Setups
file on the PC, click Save at the top of the Settings tab as
shown in  FIGURE 3-6. This will display the Save Setup
dialog where you can enter a name for the new Stored Setup,
see  FIGURE 3-32.

FIGURE 3-32  Save Setup
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Recalling a Setup

To recall a previously saved Setup, click the Stored Setups
drop-down and select the name of the Setup you wish to
recall, see  FIGURE 3-33. The selected Setup will be set
active and all the instrument settings on the various Settings
tabs will be set to the recalled values.

FIGURE 3-33  Stored Setups

Deleting a Setup

Setups can also be deleted by using
the Setup Manager (see “Setup
Manager” on page 3-34). Also, the
"<default>" and "<Instrument
Settings>" Setups cannot be deleted.

To delete a previously saved Setup, select the desired Setup
from the Stored Setups drop-down (see "Recalling a Setup"),
and click the Delete button at the top of the Settings tab, as
shown in  FIGURE 3-6. The selected Setup will be deleted
from the Stored Setups and all the settings will revert to the
<default> Setup settings.
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Setup Manager

The Setup Manager allows the user to transfer Setups
between Slm Utility-G3 and the instrument. To open the
Setup Manager, click the Setup Manager button at the top of
the Settings tab, as shown in  FIGURE 3-6. This will open
the Setup Manager dialog box as shown in  FIGURE 3-34.

FIGURE 3-34  Setup Manager

The Setups on PC window on the right hand side lists those
Setups that are saved in the Stored Setups list on the PC
(Slm Utility-G3), while the Slm Setups window on the left
hand side lists the Setups that are saved on the Instrument.
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Transferring a Setup

If the name of the Setup being
transferred already exists on the
instrument, a Question dialog will
appear asking to confirm an
Overwrite. Click Yes to overwrite the
existing Setup or No to cancel the
transfer

To transfer a Setup from Slm Utility-G3 to the instrument,
highlight the desired Setup(s) by clicking the name in the
Setups on PC window (select multiple Setups with Ctrl-
click or Shift-click) and then click the left arrow button, as
shown in  FIGURE 3-35.

FIGURE 3-35  Setup Manager: Transferring a Setup
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The selected Setup(s) will be copied to the instrument as
shown in  FIGURE 3-36.

FIGURE 3-36  Setup Manager: Transfer Complete

The process is the same for transferring from the instrument
to Slm Utility-G3. Simply highlight the desired Setup(s) in
the Slm Setups window and click the right arrow button. The
selected Setup(s) will then be copied from the instrument to
Slm Utility-G3.

Deleting a Setup

To delete a Stored Setup from either the instrument or the
PC, highlight the name of the Setup(s) to be deleted (select
multiple Setups using Ctrl-click or Shift-click) in the Slm
Setups window (for Setups stored on the instrument) or the
Setups on PC window (for Setups stored on the PC) and
click the associated Delete button, as shown in  FIGURE 3-
34.
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Manual Control Tab

The instrument can also be operated
manually when not connected to the
PC. 

To display the Manual Control Tab, click the Manual
Control tab of the Instrument Manager.

The Manual Control tab, as shown in  FIGURE 3-37,
allows the user to remotely operate an instrument connected
to Slm Utility-G3.

FIGURE 3-37  Manual Control Tab
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The “Restore Model 831” and the
“Upgrade Model 831” are only
available when connected by USB or
TCP/IP.

From the Manual Control tab, the following operations can
be performed:

•  Run the instrument

•  Stop the instrument

•  Reset the data to clear the instrument memory

•  Lock the instrument

•  Unlock the instrument

•  Browse instrument Files

•  Upgrade the instrument

•  Restore the instrument 

•  Store Data File

•  Initiate a Live Stream permitting the user to listen to
live streaming audio from the Model 831.

• Switch modes between SLM Mode, RT-60 Mode
(requires 831-RT option), and FFT Mode (requires 831-
FFT option)

Begin a Measurement

Click Run, to put the instrument into the Run mode and
begin a measurement. After clicking Run, the Run Control
section will appear as shown in  FIGURE 3-38.

FIGURE 3-38  Run Key

When the instrument is running, the Run Status will be set to
“RUNNING”. Also, the Session Log will be updated to
reflect the running status of the instrument and the date and
time the run was initiated.

Run Status
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FIGURE 3-39  Session Log: Running

Stop a Measurement

Click Stop to put the instrument into the Stop mode and
end a measurement. After clicking Stop, the Run Control
section will appear as shown in  FIGURE 3-40.

FIGURE 3-40  Stop Key

When the instrument is stopped, the Run Status will change
to “STOPPED”. Also, the Session Log will be updated to
reflect the stopped status of the instrument, along with the
data and time of the stop, as shown in FIGURE 3-41.

FIGURE 3-41  Session Log: Stopped

Reset Current Measurement

Warning! Use caution when using
this action since deleted data cannot
be recovered. Data you wish to keep
should be stored to a file.

To reset the data currently in the memory of the connected
instrument, click the Reset Current Measurement button as
shown in  FIGURE 3-42.

Run Status
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FIGURE 3-42  Reset Current Data

The data and time of a reset appears in the Session Log as
shown in  FIGURE 3-43.

FIGURE 3-43  Session Log: Reset

Locking the Instrument Keypad

The Model 831 and SoundTrack LxT, have a very useful
keypad Lock feature. The Lock Control section of the
Manual Control tab is shown in  FIGURE 3-44.

The software does not enforce the
lock setting so this menu can be used
to unlock a meter when the code is
not known.

FIGURE 3-44  Lock Control 

The Lock Status, locked or unlocked, is indicated in the
Lock Status field. Buttons for locking and unlocking the
instrument keypad are located near the bottom of the Lock
Control area.

Lock Status

Set Lock UnLock
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To Lock the instrument, click the Lock key shown in 
FIGURE 3-44, which will open the Set Unlock Code dialog
shown in  FIGURE 3-45.

FIGURE 3-45  Set Unlock Code

Permitting Calibration When Locked

To allow calibrating the instrument when Locked, check the
Allow Calibration when Locked setting check box.

Click the down arrow to the right of the “Select Lock
Mode:” field to open the drop-down menu shown in 
FIGURE 3-46.

FIGURE 3-46  Lock Mode Options
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Lock Mode

See the instrument’s user manual for
a complete description of the Lock
Mode.

There are four options available for the lock mode.

•  Unlocked: The keyboard is not locked; all functions are
accessible to the instrument user

•  Locked with Auto Store

•  Locked with Manual Store

•  Fully Locked

Click on the desired option to make a selection.

Store an Instrument File

The keys will indicate LxT or 831
depending on the instrument
connected.

To store the measurement data currently in the memory to a
data file, click Store 831 File as shown in  FIGURE 3-47.

FIGURE 3-47  Store Instrument File
3-42 Manual Control Tab SLM Utility-G3 Manual



This will display the Enter 831 Data Filename dialog as
shown in  FIGURE 3-48.

FIGURE 3-48  Enter Data Filename

A default file name will appear corresponding to the next
available file name and number. This can be modified by
typing into the data field before completing the storage
process.Click OK to complete the data storage.

Browse Instrument Files

To browse the files stored in the 831, click Browse 831 Files
as shown in  FIGURE 3-49.

FIGURE 3-49  Browse 831 Files
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This will open the 831 Files Browser window shown in 
FIGURE 3-50.

FIGURE 3-50  831 Files Browser

Rename Instrument Files

Any instrument file listed can be renamed by highlighting it
with the cursor and clicking Rename, which will create a
frame around the file name as shown in  FIGURE 3-51.

FIGURE 3-51  Rename 831 File

Modify the file name as desired and click outside the frame
to accept the new name. 
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Delete Instrument Files

Any instrument file listed can be deleted by highlighting it
with the cursor and clicking Delete as shown in  FIGURE 3-
52.

FIGURE 3-52  Delete 831 Files

Delete All Instrument Files

All instrument files listed can be deleted by clicking Delete
All as shown in  FIGURE 3-53.

FIGURE 3-53  Delete All 831 Files
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This will bring up the confirmation dialog box shown in 
FIGURE 3-54.

FIGURE 3-54  Delete Confirmation Dialog Box

Click Yes to confirm the deletion of all files.

Upgrade the Instrument

Using SLM Utility-G3, it is possible
to upgrade the instrument firmware
without opening the Instrument
Manager, as described in the section
"File" on page 2-4.

To upgrade the firmware in the instrument, first place the
firmware file on your computer using a path you will
remember. The keys will indicate SoundTrack LxT or 831
depending on the instrument connected. 

The Upgrade function is available
only when connected by USB or
TCP/IP.

Click Upgrade 831 as shown in  FIGURE 3-55.

FIGURE 3-55  Upgrade 831 
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This will display the warning message shown in  FIGURE 3-
56.

FIGURE 3-56  Upload 831 Warning Message

Press Cancel if you wish to abort the upload operation.

Press Download if you wish to download the data files and
store them to your computer before performing the upload
operation.

Press Proceed to continue the upload operation.

This will open a window containing the 831 Firmware
Loader as shown in  FIGURE 3-57. 

FIGURE 3-57  SLM Firmware Programmer
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Click Next to display the Select File box shown in  FIGURE
3-58.

FIGURE 3-58  Select File

For loading firmware files to the instrument, select one of
the following options:

•   For .ROM firmware files, select Upgrade the firmware
using a .ROM file. 

•   For .OPT firmware files, select Change installed options
using a .OPT file.

•   For firmware files to be used with the 831-INT-ET, select
Upgrade 831-INT-ET firmware.

Under the option selected, enter the path name of the
firmware file you received, or click Browse to locate and
select the appropriate file.

After selecting the appropriate option and specifying the
path for the firmware file, click Next to complete the
upgrade process.
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Restore Instrument

Restoring the instrument will delete
all measurement files and restore all
settings to factory defaults.

This action will restore the connected instrument to factory
default settings.

The Restore function is available
only when connected by USB or
TCP/IP.

Click Restore 831 as shown in  FIGURE 3-59.

FIGURE 3-59  Restore 831

This will produce the warning message shown in  FIGURE
3-60.

FIGURE 3-60  Restore 831 Warning Message

To proceed with the restoration, click Yes.

To abort the restoration, click No.
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ScreenGrabber

The ScreenGrabber program permits the user to capture a
display from the instrument screen and perform the
following actions:

•  Copy it to the clipboard

•  Save it as a bitmap file

•  Display it in a large format

•  Control the 831 by clicking on the 831 buttons

To open the ScreenGrabber program, click ScreenGrabber
as shown in  FIGURE 3-61.

FIGURE 3-61  Open ScreenGrabber Program
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The ScreenGrabber display will appear, as shown in 
FIGURE 3-62.

FIGURE 3-62  ScreenGrabber Display

ScreenGrabber Menu

Right click on the ScreenGrabber display to open the
ScreenGrabber Menu, shown in  FIGURE 3-63.

FIGURE 3-63  ScreenGrabber Menu
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Full Screen Display

Click “Full Screen” (or press Ctrl+F on the keyboard) to
obtain a large screen of the instrument display, as shown in 
FIGURE 3-64.

FIGURE 3-64  ScreenGrabber Full Screen Display

A check mark will appear to the left of the text “Full Screen”
in the ScreenGrabber menu. To return to the original display,
open the ScreenGrabber menu and click “Full Screen” (or
press Ctrl-F on the keyboard). 

Copy to Clipboard

Click “Copy to Clipboard” tester to perform this operation.
3-52 Manual Control Tab SLM Utility-G3 Manual



Save Bitmap to File

The "Save As" dialog is a system
dialog and will appear differently
depending on which OS the user is
running. Also, the path and/or folder
name shown will reflect the location
of the last file saved and will not
necessarily match what is shown in
this example screenshot.

Click Save Bitmap to File (or press Ctrl+S on the keyboard)
to perform this operation. This will open the Save As dialog,
shown in  FIGURE 3-65. Use this to define the path to the
location where the bitmap is to be stored and click Save to
complete the operation.

FIGURE 3-65  Save As
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Start Live Stream

In order to implement a live stream,
the Model 831 must be running
firmware version 1.6 or greater and
the Sound Recording Option must be
enabled.

The Live Stream permits the user to listen to live streaming
audio from the Model 831

FIGURE 3-66  Start Live Stream

Click to Start Live Stream to open the Live Stream dialog 
shown in  FIGURE 3-67.

FIGURE 3-67  Live Stream Menu

Amount of time data
has been streaming.

Amount of data
currently buffered.

831 Sample Rate

Amount of data to store
before playback begins

Turn On Automatic
Gain Control

Save as a .wav File.
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Buffer Length

The amount of data to buffer is determined by the buffer
length setting. The system will buffer the specified number
of seconds of data before beginning playback. If the amount
of buffered data falls too low, playback will be paused while
the buffer is refilled. The buffering status will be displayed
as shown in  FIGURE 3-68.

FIGURE 3-68  Live Stream Buffering 
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Save to File

Clicking Save to File will open the Select Output File
shown in  FIGURE 3-69.

The "Select Output File" dialog is a
system dialog and will appear
differently depending on which OS
the user is running. Also, the path
and/or folder name shown will
reflect the location of the last file
saved and will not necessarily match
what is shown in this example
screenshot.

FIGURE 3-69  Select Output File

Use this to select where to save the Live Stream file.
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Switching Instrument Modes

The RT-60 mode requires the
optional firmware 831-RT and FFT
mode requires the optional firmware
831-FFT. The mode buttons will be
enabled when the appropriate
optional firmware has been
installed.

The Mode Control section allows the user the change which
mode the Model 831 is operating in as shown in  FIGURE 3-
70. The Mode Status shows the current mode of the
connected instrument. To switch modes, press the button
labeled with the desired mode. Note that the mode button for
the current mode will be disabled. Also, the mode button for
any mode that is not currently installed will also be disabled. 

FIGURE 3-70  Mode Control

After clicking a mode button, a warning dialog, as shown in 
FIGURE 3-71, will be displayed allowing the user to
confirm the mode change.

FIGURE 3-71  Change Warning

When changing modes the instrument manager will be
automatically closed and reopened with settings appropriate
for the chosen mode.
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Download Tab

To display the Download tab, click the Download tab of the
Instrument Manager.

The Download tab, as shown in  FIGURE 3-72, allows the
user to download data files stored on the instrument to the
PC.

FIGURE 3-72  Download Tab
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Selecting Files to Download

The initial list of files available to download will be limited
to the data files stored in the same mode the instrument is
currently running. (i.e. if the instrument is in SLM mode,
only SLM data files will be displayed.) To see all files for all
modes, check the Show All Files check box.

The user may choose which files to download by selecting
one or more individual files, or by selecting all files. Note
that when showing all files and selecting more than one file
to download, only files that share the same mode may be
downloaded together in the same batch.

Selecting a File

To choose a file to download, simply click the filename in
the list to select the desired file. Multiple files may be
chosen by using Ctrl-click to select each individual file or by
using Shift-click to select a block of files. 

Selecting All Files

When selecting multiple data files,
all files selected will be downloaded
into a single download file with each
data file becoming a Data Record
within the downloaded file.

Clicking the Select All button will highlight all the files that
were stored in the same mode as the current instrument
mode. The button will toggle to Deselect All which, when
clicked, will deselect all highlighted files.

Add General Record Information

The general record information
added to the downloaded records
can be edited later as described in
the section "Edit of General Record
Information" on page 4-4.

By checking the Add General Record Information check box
prior to initiating the download, the user will be able to add
some general record information to each file that is
downloaded, as shown in  FIGURE 3-74.

Same Information for All Records

If the general record information being entered is applicable
to all the files in the download, the user may elect to check
the Use for all Downloaded records? check box. This will
apply the same information entered here to the current file
and all subsequent files so that the Add General Record
Information dialog will not be displayed for the remaining
files in the download.
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Saving .ldbin Files

The .ldbin file contains the meter data before it is translated
by the SLM Utility-G3 software. The file is not usually
necessary to save except in some trouble-shooting cases or
with special file import requirements.

If you select this option, you will be prompted to save the
file to a location each time you download from the meter to
the SLM Utility-G3software.

Download Files

After selecting the desired file(s), click the Download button
to initiate the download process, as shown in  FIGURE 3-72.
Progress is indicated with the Downloading box, as shown
in  FIGURE 3-73.

FIGURE 3-73  Download Progress
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If the Add General Record Information check box was
checked on the Download tab shown in  FIGURE 3-73, the
Add General Information dialog will appear after the last file
is downloaded, as shown in  FIGURE 3-74.

FIGURE 3-74  General Information

After all desired information has been entered, click OK to
continue with the next file.

Delete Downloaded Files From The Instrument

At the conclusion of the download, the dialog box shown in 
FIGURE 3-75 is displayed to indicate that the download
process has been completed and to provide the user with the
option of deleting the files which have just been
downloaded.

FIGURE 3-75  Delete Downloaded Files
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Click Yes to delete the files from the instrument, or No to
keep the files stored on the instrument.

The user must close the Instrument
Manager to be able to interact with
the Data View.

At this point, the download is complete and each data file in
the download is 'translated' into a Data Record and made
available for viewing in the Data View, as shown in 
FIGURE 3-76.

FIGURE 3-76  Data View

For information on the displaying the downloaded data and a
complete description of the Data View, see Chapter 4 "Data
View" on page 4-1.
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Session Log Entry

When the download is complete, a new entry will appear in
the session log indicating the date and time of the download
as shown in  FIGURE 3-77.

FIGURE 3-77  Session Log: Downloaded

Calibrate Tab

Click the Calibrate tab, as shown in  FIGURE 3-78, to
calibrate a connected instrument using Slm Utility-G3.

FIGURE 3-78  Calibrate
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For a complete description of the
Calibrate functionality, please refer
to the Calibration chapter of the
instrument manual.

Normally the instrument is calibrated using an acoustic
calibrator which exposes the microphone to a known sound
pressure level (dB) at a known frequency. The calibration
procedure adjusts the sensitivity of the meter so that the
meter reads the applied decibel level. 

There is, however, an alternative mode in which a voltage is
input directly to the input connector, without using the
preamplifier. In this case, the sensitivity is adjusted such that
the meter reads a user-defined decibel level. This mode is
useful when the meter is being used to measure a signal from
a transducer other than a microphone, such as an
accelerometer.

Frequency Weighting/Detector

When a calibration is performed, the instrument is
automatically set to use C-Weight for the frequency
weighting and Fast for the detector response time. The use
of C-Weighting permits the use of calibrators providing
signals in the range 200 Hz to 1,250 Hz. The most
commonly used calibrators provide signals at 1 kHz. 

The Fast detector is used to minimize the amount of time it
takes for the value of the measured level to stabilize.

When the calibration is completed, the frequency weighting
and detector are reset to those which were active prior to the
calibration.

Microphone/Preamplifier

The Microphone/Preamp section of the Calibrate tab
displays the accuracy Class according the IEC and ANSI
standards and the model number of the preamplifier. Since
these values are read from the instrument, the data appear
greyed out and are not accessible for user modification.
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Calibration Data

The Calibration Data section of the Calibrate tab, shown in 
FIGURE 3-79, is used to perform the calibration.

FIGURE 3-79  Calibration Section of Calibration Tab

Post-calibration data appears in
SLM Utility-G3 or data export files
only if the calibration is performed
on the instrument before saving the
file.

As mentioned at the beginning of the section, the calibration
can be performed using either an acoustic calibrator or a
voltage signal; usually the acoustic calibrator method is
used. The instrument can have stored in its internal memory
the specifications of four different calibrators. This data can
be input either from the front panel of the instrument or
using SLM Utility-G3, as described below.

Manual Calibration

Edit Calibrators

To edit the calibrator specifications, click Edit Calibrators
as shown in  FIGURE 3-80.

FIGURE 3-80  Edit Calibrators

Calibrator
Level

Calibrator 
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This will display a window listing all four possible
calibrators, along with their output level and frequency
values shown in  FIGURE 3-81. 

FIGURE 3-81  Calibrator Specifications Table

Any of these specifications can be edited directly from this
table. When the calibrator(s) specifications have been
entered as desired, click OK to make the changes and close
this window. 

Select Calibrator

To select the calibrator which is to be used for the
calibration, click the down arrow to the right of the
Calibrator field, which will open a drop down menu listing
all four calibrators as shown in  FIGURE 3-82.

FIGURE 3-82  Calibrator Selection Menu

Highlight the desired calibrator with the cursor and click to
make a selection.
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Perform Calibration

Click Calibrate, as shown in  FIGURE 3-83, to begin the
calibration process.

FIGURE 3-83  Initiate Calibration

A message, as shown in  FIGURE 3-84, will be displayed to
warn that data in the instrument will be lost when the
calibration is performed.

FIGURE 3-84  Unsaved Data Warning

Click OK to continue with the calibration or click Cancel to
abort the calibration process. 

When the calibration process is continued, the message
shown in  FIGURE 3-85 will appear to prompt the user to
place the calibrator over the microphone and turn on the
calibrator.

FIGURE 3-85  Turn On Calibrator Message

With the calibrator in place over the microphone and
switched on, click OK to continue.
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Satisfactory Calibration

The calibration will continue until the level measured by the
instrument is within 0.5 dB of the calibration level, at which
time the calibration will stop and the resulting data will be
displayed as shown in  FIGURE 3-86.

FIGURE 3-86  Calibration Results

Among the data presented are the Current Sensitivity, based
on the previous calibration, and the Calculated Sensitivity,
based on the results of the new calibration. Click Yes to
accept the new calibration and update the sensitivity value
stored in the instrument with the new Calculated Sensitivity.
Otherwise, click Cancel to discard the calibration and keep
the sensitivity of the instrument at the Current Sensitivity
value.

Calibration Check

When the Model 831 is connected to an Outdoor
Microphone Preamplifier and Power Supply, the SLM
Utility-G3 can be used to perform a calibration check. To
initiate a calibration check, click Calibration Check in the
calibration Data section, which will open the Calibration
Check dialog shown in  FIGURE 3-87.

FIGURE 3-87  Calibration Check Menu
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Direct Input of Microphone/Preamplifier Sensitivity

Microphone sensitivity is not
currently supported on the
SoundTrack LxT.

To utilize the nominal sensitivity of microphone/
preamplifier combination being used, click Sensitivity in the
Microphone Preamplifier section, which will open the
window shown in  FIGURE 3-88.

FIGURE 3-88  Direct Input of Sensitivity
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Calibration History

To display the calibration history, click Calibration History
as shown in  FIGURE 3-89.

FIGURE 3-89  Calibration History Button

This will bring up the Calibration History dialog box, as
shown in  FIGURE 3-90.

FIGURE 3-90  Calibration History Dialog Box
3-70 Calibrate Tab SLM Utility-G3 Manual



Calibration Spectrum

The icon to the left of a calibration indicates that there is a
calibration frequency spectrum attached to the calibration
data. The spectrum is only provided when the calibration
had been done on the instrument itself. Calibrations
performed via the SLM-Utility-G3 program do not include a
spectrum.

This feature requires optional
firmware 831-OB3, LxT-OB1 or LxT-
OB3. Also, OBA must be enabled
from the OBA Settings tab. 

When spectral data have been saved with the calibration
data, this can be displayed, as shown in  FIGURE 3-91, by
double clicking the desired calibration history record. 

FIGURE 3-91  Calibration Spectra 

This example shows a 1/3 octave spectrum. If 1/1 octaves
have been selected on the OBA Settings tab, the graph
would show a 1/1 octave spectrum.

Calibration Check History

For remote noise monitoring, you can perform a calibration
check at each remote site instead of calibrating with a sound
level calibrator. To display the results of these calibration
checks, select Calibration History from the View drop-
down, as shown previously in  FIGURE 3-90.
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Export Calibration History

To export the calibration history, click the Export button at
the bottom of the Calibration History display shown in 
FIGURE 3-90. This will open the Export Calibration
History dialog box as shown in  FIGURE 3-92.

FIGURE 3-92  Export Calibration History

Print Calibration History

To print the calibration history, click the Print button on the
bottom of the Calibration History display shown in 
FIGURE 3-90.

Certification 

It is standard practice to have a measuring instrument such
as the instrument certified by the manufacturer at regular
intervals. The interval is usually selected by the user
according to the application for which it is used, although in
some cases this might be based on a requirement established
by a client for whom measurements are being performed.
Many PCB Piezotronics Inc. customers select to have
certification performed annually. 
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To assist users in maintaining their certification schedule,
certification reminders are provided on the Calibrate tab as
shown in  FIGURE 3-93.

FIGURE 3-93  Certification Reminders

Last Certification Date

The date of the last certification is stored in the instrument as
part of the certification process.

Certification Interval

The desired interval, in years, between certifications is set
by the user by clicking the down arrow to the right of the
Cal. Interval data field, which will open the drop down menu
shown in  FIGURE 3-94.

FIGURE 3-94  Certification Interval Menu

The following choices are available:

•  1 Year

•  2 Years

•  3 Years

•  4 Years

•  Never

Click on the desired value to make a selection. This value is
stored in the instrument.
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Certification Reminder

The instrument can be set to provide an on-screen reminder
when the date for a new certification is approaching. This
message will appear at a user-selected number of days prior
to the desired certification date. This number is set by
clicking the down arrow to the right of the Cert. Reminder
data field, which will open the drop down menu shown in 
FIGURE 3-95

FIGURE 3-95  Certification Reminder Menu

The following choices are available:

•  15 Days

•  30 Days

•  35 Days

•  60 Days

•  Never

Click on the desired value to make a selection. This value is
stored in the instrument and used to determine when the
certification reminder should be displayed.
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System Tab

Click the System tab on the Instrument Manager to display
its contents.

The System tab is comprised of seven sub-tabs as shown in 
FIGURE 3-96. Each sub-page can be accessed by clicking
on the appropriate sub-tab on the System tab. Tabs that are
currently out of view can be scrolled to by using the left/
right arrow buttons at the far right.

FIGURE 3-96  Instrument Manager: System Tab
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Displaying the Instrument's Preferences

When the System tab is selected for the first time, the
preferences currently active on the instrument will be
downloaded and displayed on the appropriate sub-tabs. The
Stored Preferences drop-down will show "<Instrument
Settings>" to indicate that the displayed values are what is
currently active on the instrument. The user may refresh the
displayed values (or undo any changes made) by clicking the
Stored Preferences drop-down and selecting "<Instrument
Settings>".

Displaying the Preferences

The preferences are distributed over seven sub-tabs, as
follows:

•  Preferences 

•  Power/Lock

•  System

•  Displays

•  Reference Spectra

•  Logic I/O (831 only)

•  Communications

Each sub-tab is accessed by clicking the appropriate sub-tab
on the System tab and will display the preferences as shown
and described in the following sections.

Preferences

The Preferences sub-tab is displayed by clicking the
Preferences sub-tab on the System tab and is shown in 
FIGURE 3-97.
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FIGURE 3-97  System: Preferences

Display Options

The Display Options section of the Preferences sub-tab
allows the user to set the Language, Decimal format, Date
format, and Units preferences as shown in  FIGURE 3-97.

Language 

Clicking the down arrow to the right of the Language field
will open a drop-down menu listing the language options as
shown in  FIGURE 3-98.

FIGURE 3-98  Language Selection

Click on the desired language to make the selection.
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Decimal Format

A decimal can be represented by a period (.) or a comma (,).
Click on the radio button to the left of the desired format to
make a selection.

Date Format

The date can be represented in one of two formats:

•  dd mmm yyyy

•  yyyy mmm dd

Click on the radio button to the left of the desired format to
make a selection.

Units

The following choice of units is provided:

•  SI

•  English

Click on the radio button to the left of the desired format to
make a selection.

Other Options

Synchronize date/time with PC

Click to place a check mark in the check box associated with
the text “Sync. date/time with PC” to synchronize the date/
time of the instrument with the PC every time it is
connected.

Automatically Store Data on Stop

This option is provided to minimize the possibility that
measured data is lost by forgetting to store.

FIGURE 3-99  Auto Store 

The options are as follows:

•  None: No automatic storage of data

• Prompt: Upon stopping a measurement, a prompt is
displayed asking whether or not the data is to be stored. If
the response is Yes, the user will be prompted for a file name
to assign to the stored file.
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• Store: Upon stopping a measurement, the data is
automatically stored. There will be no prompts for a files
name; the default name will automatically be used along
with an indexed numeric designator.

Reset Prompt

The user can choose whether or not a warning prompt is
displayed on the instrument screen when the Reset button is
pressed, prior to the reset being performed. 

If this option is selected by placing a check mark in the
checkbox, the message “Are You Sure?” will be displayed
on the screen prompting the user to select Yes to continue
with the reset or No to abort the reset operation.

If this option is not activated, the reset will be performed
immediately without a prompt.

Jack Function

The AC/DC output, Voice Recorder connector on the right
side of the base of the instrument can perform either of the
following functions:

•  Provide AC and DC analog output signals proportional
to measured acoustic parameters.

• Provide a connection to a microphone-equipped
headset for the recording and playback of voice
recordings.

•  Or it can be set to Off.

Click the down arrow to the right of the data field entitled
“Jack Function” to open a drop-down menu listing the
options as shown in  FIGURE 3-100.

FIGURE 3-100  Jack Function

Click on the desired functionality to make a choice.

Takt Maximal Data (Laftm5)

Place a check in the check box to set the Model 831 to
measure and display the parameter LAFTM5, called for by a
German standard. 
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Microphone Correction

When using a free-field microphone for measurements in a
random incidence sound field, the user may wish to add a
random incidence correction to the sound level
measurement. Click the down arrow to the right of the data
field entitled “Microphone Correction:” to open a drop-
down menu listing the options as shown in  FIGURE 3-101.

FIGURE 3-101  Microphone Correction

Click on the selection desired, one of the following: 

•  Off to have no correction.

•  RI:FF: to correct a random incidence microphone for
making measurements in an acoustic free-field.

•  FF:RI: to correct a free-field microphone for making
measurements in a random incidence acoustic field.

•  FF:RI 2106/8: to correct a free-field microphone for
making measurements in a random incidence acoustic field
from within an EPS2106 or EPS2108.

•  FF:FF 2106/8: to correct a free-field microphone for
making measurements in a free-field acoustic field from
within an EPS2106 or EPS2108.

•  FF:90 2106/8: to correct a free-field microphone for
making measurements in a 90 acoustic field from within an
EPS2106 or EPS2108.
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Power/Lock

The Power/Lock sub-tab is displayed by clicking the Power/
Lock sub-tab on the System tab.

The Power/Lock sub-tab provides access to the Lock Mode
and Power Management preferences as shown in  FIGURE
3-102. 

FIGURE 3-102  System: Power/Lock

Lock Preferences

See the instrument’s user manual for
a detailed presentation of the locking
features of the instrument.

There are four options available for the lock mode.

•  Unlocked

•  Locked with Auto Store

•  Locked with Manual Store

•  Fully Locked

Click the down arrow to the right of the “Lock Mode:” ext
field to open a menu listing the options as shown in 
FIGURE 3-103.

FIGURE 3-103  Lock Mode Menu
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Click on the desired option to make a selection.

Allow Calibration When Locked

The lock function may or may not permit the operator to
manually calibrate the instrument, depending on how this
function is set. Checking the check box to the left of the text
“Allow calibration when locked:” will permit the user to
perform a calibration. 

Power Management

There are six parameters which the user can set to define the
power management of the instrument as follows:

•  Auto-Off Timer

•  Power-Save Timer

•  Backlight Timer

•  Backlight Display Mode

•  Battery Type

•  External Shutoff Voltage (831 only)

Except for the External Shutoff Voltage, each of these is set
using a drop-down menu listing the options, which is opened
by clicking the down arrow to the right of the text field
bearing the parameter name. Click the desired option to
make the selection. The available options for each of these
are shown in the figures below.

FIGURE 3-104  Auto-Off Timer Options

FIGURE 3-105  Power-Save Timer Options
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FIGURE 3-106  Backlight Timer Options

FIGURE 3-107  Backlight Options

FIGURE 3-108  Battery Type

External Shutoff Voltage

The external shut-off feature can
only be utilized when power is
delivered to the Model 831 via the
I/O connector for peripherals and
external power, such as from a
CBL130, 426A12, 831-INT,
EPS029-831, etc.

The default value is 10.8 volts, but the user can directly enter
a value between 10 and 25 volts.

System

The System sub-tab appears as shown in  FIGURE 3-109. In
addition to displaying all the options installed in the
firmware of the currently connected instrument, several
preferences related to USB Options and Instrument
Identification may be set here. The ability to mask options
(see “Masking Firmware Options” on page 3-86) and upload
new firmware (see “Firmware Upgrade” on page 3-87) are
also made available.
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FIGURE 3-109  System Subtab

The USB port must be enabled to
access the preferences on the
optional Communications sub-tab
described in “Communications
(Model 831 only)” on page -3-94.

Enable USB Port

Place a check in the check box to enable the USB Port.

USB Storage

Data can be stored either to the internal memory of the
instrument or to a memory device on the USB port. Click the
down arrow to the right of the “USB Storage” text field to
open a menu listing the options as shown in  FIGURE 3-110.

FIGURE 3-110  USB Storage Menu

Selecting No will cause all data to be stored to internal
memory. Selecting AutoSelect will cause data to be stored
to a USB memory device if present, or to internal memory if
not present or there is insufficient space.

Click on the desired option to make a selection.
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GPS

When using an external GPS with the Model 831, click the
down arrow to the right of the GPS text field to open the
GPS Control menu shown in  FIGURE 3-111.

FIGURE 3-111  GPS Control Menu

With GPS Control set to On or Auto, the zone correction
controls become available as shown in  FIGURE 3-112.

FIGURE 3-112  GPS Zone Correction

Firmware Options

Firmware options presently loaded into the instrument are
listed in the window entitled “Installed Options” on the right
side of the screen. If any of the check box of the options are
not checked, this means that they have been masked, or
disabled, as described in the next section.
SLM Utility-G3 Manual System Tab 3-85



Masking Firmware Options

Masking is temporary and does not
result in permanent loss of a
purchased option. The user can re-
enable a purchased option at any
time and a restore/format defaults
operation performed on the
instrument itself will also enable all
purchased options. When the meter
is in RT-60 mode, the RT-60,
Exceedance, 1/1 Octave, and 1/3
Octave options cannot be masked
and will not appear in the list. When
the meter is in FFT mode, the FFT
option cannot be masked and will
not appear in the list.

The user can mask, or disable, any of the options installed in
the instrument. Click the Mask Installed Options button to
open the Options Mask window shown in  FIGURE 3-113.

FIGURE 3-113  Option Mask

When the option is checked, it is enabled in the instrument.
Unchecking removes the option. Click the boxes of all
options which are to be masked, removing the check mark,
and click the Upload Mask button. 
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The message shown in  FIGURE 3-114 will appear to
indicate that the upload has been successful. 

FIGURE 3-114  Mask Options Loaded Message

You can quickly disconnect the meter
from the SLM Utility-G3 software by
clicking the Disconnect button, as
shown below.

The meter must be rebooted for the changes to take effect.
Click Yes to reboot the meter immediately. In this case the
Instrument Manager will automatically attempt to reconnect
after rebooting.

If you click No, you will need to disconnect the meter from
the program, reboot, and reconnect before the changes will
take effect. After reconnecting to the program, a prompt to
restart the Instrument Manager will appear.

Firmware Upgrade

The instrument firmware can also be
upgraded from the Manual Control
tab as described in "Upgrade the
Instrument" on page 3-46.

When upgraded firmware is available, or new options have
been purchased, the user will be supplied with a file to be
placed on the PC. When the instrument is connected to the
computer, the firmware upgrade process is initiated by
clicking on the button labeled Upgrade Model 831 beneath
the “Installed Options” window. 

Instrument Identification

Text for instrument identification purposes is entered
directly into the three fields provided using the computer
keyboard.
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Displays

Caution: each tab needs at least one
tab to display.

The Displays sub-tab is displayed by clicking the Displays
sub-tab on the System tab.

The Displays sub-tab allows the user to specify which tab
the instrument should display on startup. Also, the user may
customize the tabs displayed as available on the instrument.

Because the tabs displayed are fixed for RT60 and FFT
modes, the Displays sub-tab will not be available if the
instrument is in RT60 or FFT mode.

FIGURE 3-115  System: Display
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Pages/Startup Tab

The Pages and Startup Tab drop-downs provide access to the
same list of available tabs on the instrument. For the Startup
Tab, select which tab should be displayed first when the
instrument starts up. For the Pages, select a tab to display
and choose from all the pages available for the selected tab.

FIGURE 3-116  Tab Page/Startup Tab

Additional Displays

In addition to the pages available on the Live tab as shown in 
FIGURE 3-116, the following tabs and associated pages are
provided.

FIGURE 3-117  Pages on Overall

FIGURE 3-118  Pages on Session Log
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FIGURE 3-119  Pages on Current

FIGURE 3-120  Pages on Measurement

FIGURE 3-121  Pages on Event
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FIGURE 3-122  Pages on Time History

Reference Spectra

FIGURE 3-123  System: Reference Spectra

Requires optional firmware 831-
OB3 or LxT-OB1 or LxT-OB3 to be
enabled

The Reference Spectra sub-tab permits the user to edit
reference spectra already defined in the instrument and to
upload these to the instrument following editing.

List can include
four 1/1 octave
spectra (top four)
and four 1/3 octave
spectra (bottom
four)
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Select Reference Spectrum

Click the number of the desired reference spectrum. If that
reference spectrum has been defined in the instrument, it
will be displayed graphically.

Edit Reference Spectrum

Click Edit to edit the selected spectrum. This will bring up
the dialog as shown in  FIGURE 3-124.

FIGURE 3-124  Edit Reference Spectrum 

Use the field in this table to define the name of the reference
spectrum and to modify the spectrum levels for each
frequency. Press OK to accept the changes and close the
window.

Other (Model 831 only)

The Other sub-tab is displayed on the System tab.

The Logic I/O area provides access to the Logic In and
Logic Out preferences. These preferences allow signals to be
received from and/or sent to an external device such as the
831-INT. 

If your Model 831 is attached to a PRM2103 preamp, the
PRM2013 area provides access for specifying heater states.
See the PRM2103 Manual or Model 831 Manual for more
information on these settings.
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FIGURE 3-125  Other Subtab

Logic In 

Click the down arrow in the Logic In field to view options
for this setting, as shown in  FIGURE 3-126.

FIGURE 3-126  Logic In

Logic Out 

Click the down arrow in the Logic Out field to view options
for this setting, as shown in  FIGURE 3-127.

FIGURE 3-127  Logic Out

PRM2103

If the Model 831 is attached to a PRM2103 preamp, click
the Heater State down arrow to view options for this
setting, as shown in Figure 3-128.
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FIGURE 3-128  PRM2103 Heater States

Communications (Model 831 only)

The Communications sub-tab on the System tab provides
access to optional remote communication preferences as
shown in  FIGURE 3-129. 

The Analog Modem Settings and RS-232 Settings groups
require the optional firmware 831-MDM be installed and the
Wireless Settings group requires the optional firmware 831-
COMM be installed. If neither of these two optional
firmware packages are installed, the Communications sub-
tab will not be available on the System tab. 
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Also, to be able to edit these preferences, the instrument
must be connected via USB or Internet and the USB Host
Port preference must be enabled on the System sub-tab
shown in FIGURE 3-109.

FIGURE 3-129  System: Communications

The preferences on the Communications sub-tab are
divided into four functional groupings as described below.

The optional USB analog modem
(MDMUSB-A) is for use with
standard voice grade telephone lines
(sometimes referred to as POTS for
plain old telephone system) and will
not operate satisfactorily over VOIP
(Voice Over Internet Protocol)
telephone connections. The USB
port must be enabled to use the
features on the optional
Communications sub-tab.

Analog Modem Settings

FIGURE 3-130  Analog Modem Settings
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When the meter is in RT-60 mode
(see Chapter 7), only the RS-232
Settings group will appear on the
Communications sub-tab.

RS232 Settings

FIGURE 3-131  RS-232 Settings

Wireless Settings

FIGURE 3-132  Wireless Settings
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Clicking the Set SMS Options button displays the Set SMS
Options dialog, as shown in  FIGURE 3-133. The SMS
Options preferences allow for SMS messages to be sent by
the instrument when a specific trigger condition is detected.
Up to three trigger/phone number combinations may be
configured.

FIGURE 3-133  SMS Options

Refer to the Model 831 Manual for details on settings and
information for connecting a modem to a Model 831. If
further assistance is required, please contact PCB technical
support.

Network Settings

For Network Settings, specify the password for the network
in the Password field, as shown in Figure 3-134.

This password is only for 831-INT-
ET connections.

FIGURE 3-134  Network Settings
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Communications Watchdog

For more information on the
Communications Watchdog feature,
see the Model 831 Manual or the
831-INT Manual.

The Communications Watchdog option monitors
communciation between the 831-INT and the Model 831. If
no communication or data is received from the 831-INT by
the Model 831 within 5 minutes, the Communciations
Watchdog feature will cause the Model 831 to shut down
and restart. 

WARNING! If disconnecting the
Model 831 from an 831-INT,
remember to disable the
Communications Watchdog feature if
you are not reconnecting it.
Otherwise the Model 831 will shut
down and restart every 5 minutes.

When the Model 831 is connected to the 831-INT, the
Communications Watchdog feature is automatically
enabled. However, when removing the Model 831 from the
831-INT, the feature is not automatically disabled, so you
must disable it if you are not reconnecting it to an 831-INT.

To enable or disable the Communications Watchdog,
select or deselect the option, respectively, as shown in
Figure 3-134.

Saving Preferences

To save a set of Preferences, press Save as shown in 
FIGURE 3-135. 

FIGURE 3-135  Save Preferences

This will bring up the Save Configuration Menu shown in 
FIGURE 3-136.

FIGURE 3-136  Save Configuration Menu
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Enter a name for this set of Preferences using the keyboard
and click OK.

Recalling Preferences

To recall a previously stored set of Preferences, click the
down arrow to the right of the “Stored Preferences” field to
open a list of stored Preferences, as shown in  FIGURE 3-
137, and click the name of the desired setup to make a
selection.

FIGURE 3-137  Recall a Set of Preferences Menu

The Preferences, Power/Lock, System, Display Menus,
Reference Spectra, Other and Communications sub-tabs
will now display the parameters corresponding to this
recalled set of Preferences.

Deleting Preferences

To delete a stored set of Preferences, recall it as previously
described and then delete it by clicking Delete, as shown in 
FIGURE 3-138.

FIGURE 3-138  Delete a Set of Preferences
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Upload Preferences

To transfer preferences to the instrument, click the Upload
Preferences button on the System tab, as shown in Figure 3-
139.

t.

FIGURE 3-139  Upload Preferences
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C H A P T E R
4 Data View
This chapter describes how to view sound level data in 
SLM Utility-G3. 

Data View Menu Bar

Whenever a data file is downloaded from the instrument,
imported from a USB thumb drive, or a saved data (.slmdl)
file is opened, the data is presented to the user in a Data
View. The initial display of the Data View will be a
summary page appropriate to the mode (SLM, RA, FFT) the
instrument was in when the measurement was taken.

The Data View Menu Bar is shown in FIGURE 4-1.

FIGURE 4-1  Data View Menu Bar

The Data View Menu Bar is used to select which Data
Record to view as well as which page of the Data View to
display. The Data Record is selected by clicking the Data
Record drop-down and selecting the desired record from the
list (a separate Data Record is created for each Data File
included in the download). The buttons determine which
page of the Data View to display.

•D1/D2: Selecting D1 and/or D2 will display the SLM
Summary page with data and settings for Dose 1 (D1) and/or
Dose 2 (D2) in the Dose and Settings sections.

Display Summary

Time History

Event History
Measurement History Data Records
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•TH: Selecting TH will display the Time History Summary.

The value “-99.9” in any summary
indicates an invalid value for that
parameter in the summary. 

•EV: Selecting EV will display the Event History Summary.

•M: Selecting M will display the Measurement History
Summary.

SLM Summary 

When the Data View is first opened, the initial display will
be the SLM Summary page as shown in FIGURE 4-2

.

FIGURE 4-2  SLM Summary

Slight rounding differences can
occur between values measured and
displayed on the instrument and
those downloaded and displayed on
the computer. This difference will in
all cases be less than 0.1 dB.

The SLM Summary page of the Data View will display
summary data for the currently selected Data Record. The
data will be displayed in sections as described below.
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General Information

The General Information section displays the file name,
information concerning the instrument from which it was
downloaded (i.e. serial number and model number), user
information (User, Job Description and Location), start and
stops times of the measurement, and calibration information.
In the example presented here, the general information input
during the download process was as shown in FIGURE 4-3.

FIGURE 4-3  SLM Summary: General Information
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Edit of General Record Information

To edit the User, Job Description, Location, and Note fields
of the SLM Summary, from the Main Menu click Options-
>General Information to display the General Record
Information dialog as shown in FIGURE 4-4.

FIGURE 4-4  Edit of General Record Information

This is the same dialog as presented during the download if
the Add General Record Information check box was
checked when the file was downloaded (see "Download
Tab" on page 3-58).

Note

The Note section, as shown in FIGURE 4-5, displays the
information entered into the Note field of the General
Record Information dialog as shown in FIGURE 4-4.

FIGURE 4-5  SLM Summary: Note

Overall Data

The Overall Data section reports the overall sound
measurement data and sound exposure data, as well as the
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date and time of the max and min values, measured during
the runtime of this measurement.

FIGURE 4-6  SLM Summary: Overall Data
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Statistics

The Statistics section reports statistical data measured
during the runtime of this measurement.

FIGURE 4-7  SLM Summary: Statistics

Dose

The Dose section reports the measurement results related to
noise dose.

FIGURE 4-8  SLM S0ummary: Dose Data

Display of Dose Data

The SoundTrack LxT and the Model 831 (with optional
firmware 831-IH installed) can measure two separate noise
doses using setup parameters which are selected
independently. Dose related data is reported in both the Dose
and Settings sections of the SLM Summary. The user can
select to report data related to Dose 1 and/or Dose 2 by
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selecting the appropriate D1 and/or D2 buttons on the left of
the Data View Menu Bar, as show in FIGURE 4-1. When
both buttons are selected, the Dose data will be displayed
side by side as shown in Figure 4-8. When only one of the
Dose buttons is selected, the data for that Dose will be
displayed in the same column as all other data.

Settings

Note that the displayed parameters
associated with noise dose represent
Dose 1, Dose 2, or both, as
described in section "Display of
Dose Data" on page 4-6.

The Settings section reports the value of certain settings in
effect at the time the measurement was taken.

FIGURE 4-9  SLM Summary: Settings
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1/1 Spectra & 1/3 Spectra

The 1/1 Spectra and 1/3 Spectra sections display the OBA
data for full octave and third octave, respectively. These
sections will only be displayed if the 1/1 and/or 1/3 OBA
Bandwidth settings were selected for this measurement.

FIGURE 4-10  SLM Summary: 1/1 & 1/3 Octave Spectra
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Weather

The Weather section reports the weather data accumulated
over the runtime of this measurement. This section will only
be displayed if the Weather option was selected for this
measurement.

FIGURE 4-11  Measurement Summary: Weather

Calibration History

The Calibration History section reports the last ten
calibrations available on the meter at the time this
measurement was stored. The calibrations are displayed in
descending order by date with the most recent calibration at
the top of the list. This section will not be displayed if no
calibration histories are available.

FIGURE 4-12  SLM Summary: Calibration History
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Optional Summary Pages

The Time History (TH), Event History (EV), and
Measurement History (M) summary pages are displayed by
clicking the appropriate button on the Data View Menu Bar,
as shown in FIGURE 4-1. These pages will only be
available if the selected Data Record includes a Time
History, an Event History, and/or a Measurement History. 

Time History Summary

The Time History Summary page will display the Record #,
Date, Time, and the first six time history metrics selected for
each time history record included in the Data Record, as
shown in FIGURE 4-13. To display all the time history
metrics, the Data Record must be exported (see Chapter 5
"Export Data" on page 5-1).

FIGURE 4-13  Time History
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Event History Summary

The Event History Summary page will display the Record #,
Date, Time, Duration, and the first five event history metrics
selected for each event history record included in the Data
Record, as shown in FIGURE 4-14. To display all the event
history metrics, the Data Record must be exported (see
Chapter 5 "Export Data" on page 5-1).

FIGURE 4-14  Event History

Measurement History Summary

The Measurement History Summary page will display the
Record #, Date, Time, Duration, and the first five
measurement history metrics selected for each measurement
history record included in the Data Record, as shown in
FIGURE 4-15. To display all the measurement history
metrics, the Data Record must be exported (see Chapter 5
"Export Data" on page 5-1).

FIGURE 4-15  Measurement Data
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Printing a Summary

To print a summary page, select the desired summary in the
Data View and click the Print button on the Main Toolbar as
shown in FIGURE 4-16, or select File->Print from the Main
Menu, or press Ctrl-P on the keyboard. The default Print
dialog will be displayed. After configuring the desired print
options, click OK to complete the process.

A preview of the printed output may also be displayed by
selecting File->Print Preview from the Main Menu.

FIGURE 4-16  Main Toolbar: Print

Saving a File

To save the file, click the Save button on the Main Toolbar,
as shown in FIGURE 4-17, or select File->Save from the
Main Menu, or press Ctrl-S on the keyboard. The default
Save As dialog will be displayed. After selecting the desired
destination folder and filename, click Save to complete the
process.

If the file has already been saved before, no Save As dialog
will appear and the existing file will be overwritten. To save
to a different location or filename, select File->Save As from
the Main Menu.

FIGURE 4-17  Main Toolbar: Save
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Opening a Saved File

To open a saved file, click the Open button on the Main
Toolbar, as shown in 4, or select File->Open from the Main
Menu, or press Ctrl-O on the keyboard. The default Open
dialog will be displayed showing all files with the Slm
Utility-G3 default extension of .slmdl. Files with an .slmdl
extension are files that have been previously saved by Slm
Utility-G3. Browse to the location of the desired file, select
it, and click Open to complete the process.

Slm Utility-G3 can also open files with a .ldbin extension.
When files are downloaded from the instrument, a slm.ldbin
file is created that holds all the data files in a raw data
format. Slm Utility-G3 then converts the slm.ldbin file into
the Data Records which are presented to the user in the Data
View. To open a .ldbin file, click the file extension drop-
down and choose Larson Davis binary files (*.ldbin). The
file list will now show .ldbin files. To see both .slmdl and
.ldbin files in the same location, select All Files (*.*) from
the file extension drop-down.

FIGURE 4-18  Main Toolbar: Open

Importing Data From USB Memory

A detailed description of downloading data from the internal
memory of the instrument using the Instrument Manager
was presented in the section "Download Tab" on page 3-58.
However, when using the Model 831, data can also be saved
to a USB memory device. 
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To transfer data from a USB memory device into Slm
Utility-G3, connect the USB memory device to the PC and
select File->Import from the Main Menu as shown in
FIGURE 4-19.

FIGURE 4-19  File Menu
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This will display the Open File dialog shown in FIGURE 4-
20.

FIGURE 4-20  Open File

Click the down arrow in the “Look in:” window to open the
menu shown in FIGURE 4-21.

FIGURE 4-21  Open File Browser

831 Data Files
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The 831 data files will be located in the 831_Data folder in
the Removable Disk. Click the folder to display the 831 data
files, as shown in FIGURE 4-22.

FIGURE 4-22  Open File with 831 Data Files

If importing data from a USB flash
drive, do not modify the file structure
of the imported data on your PC
hard drive.

Select the data file(s) you wish to import and click the Open
button to begin the process. The data file will be translated
into a Data Record and presented to the user in the Data
View, as described at the beginning of this chapter.
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Closing the Data View

To close the Data View, click the Close button (red X) at top
right corner. If the downloaded file has not yet been saved, a
prompt to save message will be displayed as shown in
FIGURE 4-23. Click Save to save the file as outlined in
"Saving a File" on page 4-12, click No to close without
saving, or click cancel to cancel the close operation.

FIGURE 4-23  Prompt to Save

Measurement Log

The Measurement Log displays the Record Type, Cause, and
Date/Time of each Session log event.

To open the Measurement Log, click the Measurement Log
button on the Main Toolbar, as shown in FIGURE 4-24. This
will display the Measurement Log dialog as shown in
FIGURE 4-25.
 

FIGURE 4-24  Toolbar: Measurement Log
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FIGURE 4-25  Measurement Log

If the Measurement Log contains a record with a missing
sound recording file, the record icon is displayed as shown
in Figure 4-26.

FIGURE 4-26  Missing Sound Recording File

Voice Annotation and Audio Recording

Playback 

Note: the default media player
associated with .wav files in
Windows will be used to play the
sound recordings

All sound recordings, including Voice Annotations, in the
Measurement Log will be indicated by a speaker icon in the
left most column of the display, as shown in FIGURE 4-25.
To listen to any given sound recording, click the speaker
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icon for that recording. The recording will be converted to a
temporary .wav file and passed to Windows for playback.

Alternative Playback Method

In the section "Saving an Audio Record as a Wave File" on
page 4-19, it can be seen that there is an option Play in
addition to saving the audio records. Clicking Play will also
playback the selected audio record.

Amplify Sound Record

Note that the fixed scale factor will
be lost when the amplify feature is
utilized.

When playing back low level voice annotations and sound
recordings, if you wish to amplify the output level, check the
“Amplify sound record” check box. This will apply a fixed
gain to the audio playback only and will not alter the original
sound record.

Saving an Audio Record as a Wave File

To save any audio recording as a wave file, right-click the
speaker icon for the desired record to display the popup
menu as shown in FIGURE 4-27. Select Save audio record
as .wav file and the Windows standard Save As dialog box
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will be displayed. Select the desired destination folder and
filename and click Save to complete the process.

FIGURE 4-27  Save Audio Records as Wave Files

Saving All Audio Records as Wave Files

To save all audio recordings as wave files, on the popup
menu, as shown in FIGURE 4-27, select Save all audio
recordings as .wav files. Now select the desired destination
folder and base filename (default is the name of the current
Data Record) in the Windows standard Save As dialog and
click Save to continue. At this point, all sound recordings in
the current Data Record will be saved as a .wav file in the
selected destination folder. Each sound recording will be
given a unique name using the following format: 

<basename>.<type>X_<datetime>.wav where <basename>
is the filename selected on the Save As dialog, <type> is
either SOUND or VOICE, X is the sequential number of the
<type> of recording, and <date/ time> is the Date/Time the
recording was made.
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C H A P T E R
5 Export Data
This chapter describes how Slm Utility-G3 can export 
measurement data to a text file, a CSV file, or to an Excel 
Workbook for further processing and reporting.

Exporting Measurement Files

Excel 2003 or later is required for an
Excel export. Excel 2010 is required
for full support of an FFT export.

Begin by selecting the Data Record for the measurement you
wish to export.

FIGURE 5-1  Data View: SLM Measurement Summary 
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Click the Export Data icon on the SLM Utility-G3 toolbar.

FIGURE 5-2  Main Toolbar: Export Data

This will open the Export Data dialog shown in FIGURE
5-3.

FIGURE 5-3  Export Data

Select which data sections to export by checking the check
box for each desired section.
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Select Export Format

Text files are typically used to export
data to word processing programs.
Comma-delimited files are used to
export data to spreadsheet
programs.

The data may be exported in one of three formats:

• Excel Workbook (Excel 2003 or later required)

When exporting to Excel, each section selected for export
will be exported to a separate worksheet. Note that Excel
2003 is limited to 256 columns and 65,536 rows. For this
reason, any data section that exceeds 65,000 rows will be
split into multiple worksheets (this is most common with
Time History records with a very fast sample period).

You must close any open Excel files
before exporting to Excel. If an Excel
file is open, a warning will appear
indicating that the export cannot
proceed until the file is closed.

• Comma Delimited File (csv)

The CSV export will export all selected sections into a
single file, using the comma (,) as the field delimiter. When
exporting on a PC with locale settings that use the comma as
the decimal separator, a semi-colon (;) will be used as the
field delimiter instead.

• Text

When the Text format is selected, the Field Delimiter drop-
down will appear, as shown in FIGURE 5-4, allowing the
user to specify a comma (,), a pipe (|), or a (tab) as the field
delimiter. In all other respects, the resulting output file is the
same as a CSV export.

FIGURE 5-4  Field Delimiter, Text File Export

Export All Files

If more than one Data Record exists in the Data View, the
user may export all Data Records at once by checking the
Export all downloaded files check box. In this case, the
Output Filename will be automatically generated from the
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Data Record name. An optional prefix may be used by
checking the Use Prefix check box and entering the prefix in
the edit field.

Export the File

Press OK in the upper right corner to implement the export
of the file.

In many instances, the user wants to examine the exported
file, and possibly use it immediately for further processing.
For this reason, the option to automatically launch the
viewer application is provided in the Export File Menu. This
feature is described in the following section.

Date Formats for CSV and Text Files

When exporting to a csv or text file and the instrument’s date format is dd/mm/yyyy, the warning 
message shown in FIGURE 5-5 will appear, asking if you want to convert to the yyyy/mm/dd format 

because this format is more universally recognized and is less likely to have conversion problems.

FIGURE 5-5  Date Format Conversion Message

Automatically Launch Viewer Application

If “-99.9” appears in an exported
data field, it represents an invalid
value for the field.

To automatically launch an application to view the exported
data, check the Automatically Launch Viewer App check
box. By default, this will launch the system defined
application for each extension type (i.e. Excel for Excel
(.xls) and CSV (.csv) and Notepad for Text (.txt) formats)
when the export is finished. The user may also specify
which application to launch for CSV (.csv) and Text (.txt)
exports.
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C H A P T E R
6 Remote Connection
The Remote Connection option is used to communicate 
with a Model 831 at a remote location via wireless 
modem, analog modem, or the internet.

Initiating a Remote Connection

The proper settings for remote
communications must be set in both
the instrument and in Slm Utility-G3
software before initiating a remote
connection. See the instrument
manual and "Communications
(Model 831 only)" on page 3- 94 of
this manual for further information.

To initiate a remote connection, click Connection on the
main menu bar, highlight Remote to show the sub-menu,
then click the desired connection type as shown in FIGURE
6-1.

FIGURE 6-1  Remote Connection Menu

During the same session when
working with the SLM Utility-G3,
the connection preference will be
remembered. Clicking on the
Connect Icon will bring up the last
used connection method.

For a remote connection to succeed, the remote instrument
must be configured to accept a connection using the
connection type selected. Only one remote connection type
may be active on the instrument at any given time.
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Wireless Connection

When choosing the Wireless connection type, the Remote
Sites dialog will be displayed as shown in FIGURE 6-2. 

FIGURE 6-2  Remote Sites

Slm Utility-G3 connects to a Model 831 via wireless modem
by sending an SMS message to the instrument, opening a
TCP/IP socket on the PC, and then waiting for the incoming
connection request from the instrument. The SMS message
consists of a specially formatted string which contains the IP
address and port number. When the instrument receives the
SMS message, it will initiate a TCP/IP connection request to
the IP address and port number specified in the SMS
message. 
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Step 1 Select which SMS mode to use.

Step 2 Fill in the address field with the email address 
provided by the cellular provider. This will 
typically be in the form of <phone number of 
wireless modem>@<some domain defined by the 
carrier>. This field will be disabled if sending an 
SMS manually.

Step 3 Select the COM port of the wireless modem 
attached to the G3 computer. This field will only 
be enabled when sending an SMS via a wireless 
modem attached to the PC.

Step 4 Enter the public IP address of your PC. To 
determine the IP address to use, visit 
www.canyouseeme.org or contact your network 
administrator.

Step 5 Enter a valid Port number for TCP/IP 
communication. Please make sure that the port is 
not blocked by firewalls. Also note that if you are 
using a cellular modem to connect to internet on 
the PC side make sure that the cellular provider 
does not do port blocking. The port number used 
must be greater than 1023 and less than 65536.

Step 6 Enter a timeout, in seconds, for the connection 
request to complete. The time required varies 
based on cellular and internet traffic volumes at 
the time of the request. A timeout of 5 minutes 
(300 seconds) is suggested as a starting point. 

Step 7 Finally, enter the password which is set in the 
Model 831 and click OK.

Implementing the Connection

There are three ways to send the SMS message: via e-mail,
via an attached wireless modem, or manually. Select the
SMS mode by clicking the appropriate radio button in the
Select SMS mode section of the dialog as shown in FIGURE
6-2.
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Send via Wireless Modem

To send via wireless modem, the PC running Slm Utility-G3
must have a wireless modem attached and correctly
configured. Select Send SMS via wireless modem radio
button and fill out the remainder of the dialog, shown in
FIGURE 6-3. Select the appropriate COM port for the
attached wireless modem from the second drop down list
and all other entries are the same as for the e-mail option.

FIGURE 6-3  Send SMS via Wireless Modem 
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Send Manually

The manual option requires that the SMS message is sent
externally from G3 (i.e. via cell phone or web page). G3 will
open the TCP/IP port and wait for the incoming connection
request, as shown in FIGURE 6-4, but will not generate or
send an SMS message internally.

FIGURE 6-4  Send SMS Manually

The body of the SMS message must be in the following
format:

IPP<IP address>:<port>IPP

Using FIGURE 6-4 as an example, the correct SMS message
to send would be: IPP209.253.32.227:19576IPP.
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How to Choose Which Method to Use:

Send SMS via email (recommended solution) 

Why Why Not

Most inexpensive solution and uses existing internet 
connection.

Not Automated

SMS messages are limited to160 characters. In 
some company settings, automatic text is added to all 
outgoing emails, which makes the SMS messages too 
large. Some providers will then break the message into 
smaller pieces and then send multiple SMS messages 
to the internet. In this instance, the 831 will reassemble 
the SMS message. 

However some providers will not send the actual 
message, but rather a link to the message, thus 
rendering the SMS message with the connection 
unavailable to the instrument.Under these conditions 
you must send the message manually using a non-
company email system or by using a cell phone to send 
the SMS directly to the instrument. 

Send SMS via wireless modem 

Why Why Not

Ease of use additional modem and SIMM card required.

Cellular service provider may only support MMS 
via email.
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Send SMS Manually (Least desirable solution, intended only for testing pur-
poses

Why Why Not

Can send messages from cell phone Not Automated

Most difficult and 
time consuming

SMS messages are limited to160 characters. In some 
company settings, automatic text is added to all outgoing 
emails, which makes the SMS messages too large. Some 
providers will then break the message into smaller 
pieces and then send multiple SMS messages to the 
internet. In this instance, the 831 will reassemble the 
SMS message. 

However some providers will not send the actual 
message, but rather a link to the message, thus rendering 
the SMS message with the connection unavailable to the 
instrument.Under these conditions you must send the 
message manually using a non-company email system or 
by using a cell phone to send the SMS directly to the 
instrument. 
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Analog Modem Connection

When choosing the Modem connection type, the Connect to
Analog Modem dialog box will be displayed, as shown in
FIGURE 6-5.

FIGURE 6-5  Connect to Analog Modem

Step 1 Enter the remote site telephone number.

Step 2 Select local modem port number. When the 
“Connect using TAPI” check box is not checked, 
select the appropriate COM Port to which the 
modem is connected. When the check box is 
checked, the menu will list only TAPI (Telephony 
API) enabled services attached to the PC.

Step 3 Select the Baud Rate.

Step 4 Enter the numeric password that was used in 
Model 831 and click CONNECT.
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Internet Connection

When choosing the Internet connection type, the Remote
Internet Site dialog is displayed as shown in FIGURE 6-6.

If you enter a valid host name, the IP
address is automatically looked up.

FIGURE 6-6  Remote Internet Site

The IP address and Port number are
configured in the 831 INT-ET. Please
refer to the 831 INT-ET manual for
more information.

Step 1 Enter the host name or IP address assigned to the 
remote 831 INT-ET.

Step 2 Enter the Port number assigned to accept 
incoming connection requests and click Connect.

Step 3 Enter the network settings password. This should 
correspond to the password entered on the 
Communications sub-tab of the System tab of the 
Instrument Manager.

Step 4 Selct the Timeout period. 

Step 5 Click Connect.
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C H A P T E R
7 RT-60
RT-60, or Reverberation Time, is a measurement of the 
time a sound takes to decay 60 dB from its initial sound 
pressure level.

This chapter covers the changes in Slm Utility-G3 when 
connected to an instrument in RT-60 mode.

Accessing RT-60 Mode

Note that RT-60 mode is only
available if the optional firmware
831-RT has been installed.

When using Slm Utility-G3 software, the mode of the Model
831 can be changed through the Manual Control page of the
Instrument Manager. To change to RT-60 mode, press the
RT-60 mode button in the Mode Control section as shown in 
FIGURE 7-1.

 

FIGURE 7-1  Manual Control: RT-60 Mode
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Settings Page 

This section describes the settings available when SLM
Utility-G3 is connected to an instrument in RT-60 mode.
These settings are used to configure the instrument for an
RT-60 measurement. For a complete description of the
Settings page, please refer to the Settings Page section of
Chapter 3 "Settings Tab"  on page 3-5.

FIGURE 7-2  Settings
7-2 Settings Page SLM Utility-G3 Manual



Instrument Settings

The RT-60 settings are distributed over three sub-pages as
follows:

General

FIGURE 7-3  Settings: General

The General sub-page has the following settings:

Project Name: This will be the default name when storing a
file.

Measurement Description: Up to 63 characters can be used
to describe the measurement.

Exit Time: The amount of time after RUN has been pressed
until the Model 831 begins to gather data. This time should
be used to exit the room prior to the measurement.

Lowest Band/Highest Band: These two settings define the
range of filters over which the reverberation time is
computed.
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RT-60

Note: When the method is set to
Impulse, the Build Time setting is not
enabled.

The settings on the RT-60 sub-page define how the sound
decay will be measured. Some settings are enabled/disabled
based on the method chosen.

Interrupted Method

FIGURE 7-4  Settings: RT-60 (Interrupted Method)

OBA Bandwidth: Select measurement bandwidth,
1/1 or 1/3 octave.

Method: The method of measurement, either Impulse or
Interrupted Noise.

Note: The Trigger Source frequency
range will be limited to be between
the Lowest and Highest filters
(inclusive) as set on the General sub-
page shown in  FIGURE 7-3.

Trigger Source: Allows the user to select which filter
output to use as the trigger source when making a
measurement and can be:
• Z-weighted.
• Mid-Band: equivalent energy of 500 Hz to 2 kHz filters,
inclusive.
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• A single 1/1 or 1/3 octave filter, based on the bandwidth
selected.

Trigger Level: The signal level at which a reverberation
time measurement is triggered. When using the Impulse
method, data acquisition is triggered when the rising sound
level exceeds the configured Trigger Level. When using the
Interrupted Noise method, data acquisition is triggered when
the decaying sound level drops to 5 dB below the configured
Trigger Level.

Count: Indicates the number of successive reverberation
time measurements to take at a position. Once the
measurement is started by pressing RUN, the Model 831
will begin making the measurement and automatically stop
when the configured count has been reached.

Sample Rate: Sets the time interval between samples of the
sound decay curve.

Build Time: Build time is available when the method is set
to Interrupted Noise. The Build Time is the time the noise
level must be above the configured Trigger Level to
sufficiently energize the room. For example, if the Build
Time is set to five seconds, the sound source will be on for
five seconds plus the time it takes for the sound level to
reach the trigger level.

Run Time: Sets the post trigger run time. The maximum
value is dependent upon the Sample Period as indicated in
Table 7-1.

Table 7-1 Max Run Time vs Sample Period

OBA Range: For most reverberation time measurements,
the OBA Range will be set to Normal. Low would be used
when the range of the measurement remains near the noise
floor of the filters.

+20 dB Range: Should only be used for Interrupted Noise
since impulses can quickly exceed 120 dBZ.

Sample Period (ms) Max Run Time (s)

20 19

10 18

5 9

2.5 4
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Source

The settings on the Source sub-page are only available when
the Interrupted method is selected on the RT-60 sub-page.
For the Impulse method, an external noise source (i.e. starter
gun, balloon, etc.) is used so these settings do not apply.

FIGURE 7-5  Settings: Source (Interrupted Method)

RT-60 Noise: The signal used to energize the room can be
generated by an external sound source or using the internal
noise source of the Model 831. If using an external source,
select "Off". If using the internal noise source, select
"White" or "Pink" noise. The Model 831 outputs the noise
signal via the AC output connector. An external amplifier
and speaker system are needed to sufficiently energize a
room.

Attenuation: This is used to reduce the output signal from
the Model 831 in instances where the level might overload
the amplifier input.
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Setup Manager

For additional information on the use of
the Setup Manager, see Setup Manager
on page 3-34.

The Setup Manager allows transferring user-defined
measurement setups stored on the instrument to the PC and
vice versa.

Notice that three default RT-60 setups are provided for
configuring the instrument to perform RT-60 measurements
using the Impulse and Interrupted methods as shown in 
FIGURE 7-6.

FIGURE 7-6  Setup Manager
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Data View

The Data View is displayed to the user whenever a data file
is downloaded from the instrument, Imported from a USB
thumb drive, or a saved data (.slmdl) file is Opened. The
initial display of the Data View will be a Summary of the
first Data Record and is fully described in Chapter 4,
beginning on page 4-1. 

This section will describe the Data View for a RT-60
Summary as shown in  FIGURE 7-7.

FIGURE 7-7  Data View: RT-60 Summary

Please refer to Chapter 4 for a description of any sections not
explicitly described here.

RT-60 Ensemble

The RT-60 Ensemble section, shown in  FIGURE 7-8
displays the selected T20 or T30 Ensemble Average of all
included decay measurements.
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FIGURE 7-8  RT-60 Summary: RT-60 Ensemble 

Freq. (Hz): The range of frequencies over which the decay
time is measured. Displayed in either 1/1 or 1/3 octave
bands as determined by the Bandwidth setting as shown in 
FIGURE 7-4 and may also be limited by the Lowest Band/
Highest Band filter setting as shown in  FIGURE 7-4.

Leq: Computed as the Leq between the initial exceedance of
the trigger level to when the signal falls below the trigger
level minus 5 dB, displayed in dB for each frequency.

Lmax: The maximum value of the time history at each
frequency, displayed in dB.

Lbk: The background level measured for each frequency,
displayed in dB.

T20 (T30): The T20, or T30 decay time for each frequency,
displayed in milliseconds.

BT: The product of the filter bandwidth and the T20 or T30
decay time for each frequency.

BK: A measure of the dynamic range between the excitation
signal and the background noise level, displayed in dB for
each frequency. 

NL: The degree of non-linearity of the T20 or T30 portion
of the decay curve, and is reported as permillage (parts per
thousand) deviation from perfect linearity for each
frequency.
SLM Utility-G3 Manual Data View 7-9



Cu: The degree of curvature, and is a comparison of the T20
and T30. Cu is expressed as the percentage deviation from
being perfectly in-line for each frequency.

SD: The standard deviation of the measurement results for
the T20 or T30 decay times, displayed as a percentage for
each frequency.

The Quality Indicators (BT, BK, NL, Cu, & SD) are
displayed with Green, Yellow, or Red backgrounds to
indicate Good, Fair, or Poor, respectively. Please refer to
Table 7-2 below and the Quality Indicators section of the
Model 831 Technical Reference Manual for a complete
description and the associated criteria for each Quality
Indicator. 

Table 7-2 Quality Indicator Criteria

Green =Good Yellow =Fair Red =Poor

>16 NA ≤ 16
BK ≥ 35 dB (T20)

≥ 45 dB (T30)
NA < 35 dB (T20)

< 45 dB (T30)

NL ≤ 5% 5‰ < NL ≤ 10% > 10%
Cu 0%≤ Cu ≤ 5% 5% < Cu ≤ 10%

-5% < Cu < 0%
> 10%
≤ -5%

SD ≤ 5% 5% < SD ≤ 10% > 10%
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RT-60 Measurement Grade

The RT-60 Measurement Grade section, shown in  FIGURE
7-9, displays the estimated Accuracy Grade of this
measurement as described in ISO 3382-2(2008).

FIGURE 7-9  RT60 Summary: RT-60 Measurement Grade

Estimated Grade: The model 831 reports three methods of
differing measurement uncertainty as described in ISO
3382-2:2008(E). The grades are Precision, Engineering, and
Survey. If the measurement settings preclude achieving one
of the uncertainty grades described, “Settings Conflict” will
appear in this field. This usually means that the Lowest
Band and/or Highest Band setting were outside of the
required range for all grades. Refer to Table 7-3 below and
ISO 3382-2:2008(E) for a complete description of the
uncertainty grade criteria.

Frequency Range: The frequency range used for this
measurement.

• Actual: The actual frequency range for this measurement
determined by the Lowest Band/Highest Band settings.

• Required: The required frequency range for the estimated
grade. 
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Positions: The number of positions used in the
measurement.

• Actual: The actual number of times the RUN button was
pressed.

• Required: The required number of positions for the
estimated grade.

Decays/Positions: The number of decays measured at each
position.

• Actual: The minimum number of decays across all
positions that meet the estimated grade requirements. This
will usually be the same as the Count setting but may be
fewer if some decays have been excluded.

• Required: The required number of decays at each position
for the estimated grade.

Total Positions: Total number of positions.

Position: A list of each position.

Decays: The number of included decays at each position.

Table 7-3 Minimum Number of Positions and Measurements

Survey Engineering Precision

Source-microphone combinations 2 6 12

Source-positions 1 2 
Microphone-positions 2 2 3

No. decays in each position 
(interrupted noise method)

1 2 3

 Method Impulse or
Interrupted

Interrupted Interrupted

Filter bandwidth 1/1 1/1 or 1/3 1/1 or 1/3

Frequency Range (minimum) 250 Hz to 2 kHz 125 Hz to 4 kHz (1/1)
100 Hz to 5 kHz (1/3)

Standards ISO 10052 ISO 140
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OBA

The OBA section is displayed in  FIGURE 7-10.

FIGURE 7-10  RT-60 Summary: OBA

# OBA Overloads: The number of OBA overloads that
occurred during this measurement.

OBA Overload Duration: The total duration of all OBA
overloads.

1/1 OBA Under Range: This table shows the Z Weighting
under range value and the Noise Floor value for each
frequency. 

Settings

The Settings section, shown in  FIGURE 7-11, displays the
active settings used for this measurement.

FIGURE 7-11  RT-60 Summary: Settings
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Exporting Data

When exporting RT-60 data, the Export Data dialog will
appear as shown in  FIGURE 7-12.

FIGURE 7-12  Export Data: RT-60

Note: The RT60 Detail Time Series
sheet is automatically included when
RT60 Detail is selected AND the
Save All Time Series control option
was enabled when the measurements
were made.

When exporting to an Excel Workbook, the RT60 data will
be exported to the selected worksheets.
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Summary Sheet

The Summary sheet will contain the same information as the
Data View with the exception that the RT-60 Ensemble
section will display both T20 and T30 data. A sample
screenshot is shown in  FIGURE 7-13. Please refer to the
Data View section of this chapter for a complete description.

FIGURE 7-13  RT-60 Export Summary Sheet

RT-60 Detail Sheet

The RT-60 Detail sheet will display an RT-60 detail
(including both T20 and T30 data) of each decay captured
over the entire measurement. A sample screenshot is shown
in  FIGURE 7-14. Additionally, each decay record will
indicate if an Overload was detected (Yes/No) and whether
or not the decay is excluded from the Ensemble average (an
X in the Exclude column indicates it is excluded).
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FIGURE 7-14  RT60 Export: RT60 Detail sheet

Ensemble RT60 Time Series Sheet 

The Ensemble RT-60 Time Series sheet will display a
spectra by time table of all of the decays captured during this
measurement. The data from any decays excluded from the
ensemble will not be included.

RT-60 Detail Time Series Sheet 

The RT-60 Detail Time Series sheet will show a spectra by
time table for each individual decay captured during this
measurement. All decays will be shown, whether excluded
or not.
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C H A P T E R
8 FFT

The optional FFT mode provides signal analysis using a 
Fast Fourier Transform. This chapter describes SLM 
Utility-G3 functionality when connected to an 
instrument in FFT mode.

Accessing FFT Mode

FFT mode is only available if the
optional firmware 831-FFT has been
installed on the Model 831.

When using Slm Utility-G3 software, the mode of the Model
831 can be changed through the Manual Control page of the
Instrument Manager. To change to FFT mode, click the FFT
mode button in the Mode Control section as shown in 
FIGURE 8-1.

FIGURE 8-1  Manual Control: FFT Mode

After clicking a mode change button, the Mode Change
Warning dialog box will appear. Click Yes to continue with
the mode change, which will close and re-open the
Instrument Manager in FFT mode. Click No to cancel the
mode change.

Settings Page

This section describes the settings available on the Settings
page when SLM Utility-G3 is connected to an instrument in
FFT mode. These settings are used to configure the
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instrument for an FFT measurement. For a complete
description of the Settings page, please refer Chapter 3
"Settings Tab" on page 3-5.

When first displayed, the Settings page will display the
current instrument settings. Settings can be changed and
saved to the meter by clicking the Upload Settings button or
to a file by clicking Save. (For a complete description of the
Setup Manager, and how to Save, Delete, and/or Recall
saved Setups, please refer to the appropriate section of
Chapter 3.)

Instrument Settings

The FFT settings are distributed over two sub-pages as
follows:

General

The General sub-page has the following settings:

• Project Name: This will be the default file name when
storing a file.

• Measurement Description: Up to 63 characters can be
used to describe the measurement.

FFT

The FFT sub page, as shown in  FIGURE 8-2, provides
access to settings that define the parameters of an FFT
measurement. The Count and Time settings will be enabled
or disabled based on the Run Mode setting, as described
under Run Mode on page 8-6.
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FIGURE 8-2  Settings: FFT
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For more information on FFT
settings, see the “FFT and Tonality”
chapter in the Model 831 manual.

Frequency Span: defines the upper end of the frequency
response. Choices range from 100 Hz to 20 kHz as shown in 
FIGURE 8-3.

FIGURE 8-3  Frequency Span

Lines: defines the number of discrete frequency bands.
Choices range from 400 to 6400 as shown in  FIGURE 8-4.

FIGURE 8-4  Lines

Window: selects a window to provide emphasis or balance
between frequency selectivity and amplitude ripple as the
frequency varies from one bin to another. Choices are shown
in  FIGURE 8-5.

FIGURE 8-5  Window

Frequency Weighting: A broadband Leq and Lpeak level
will be measured using this weighting as well as being
applied to the FFT spectrum.
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For more information on measuring
tonality with the Model 831, see the
FFT chapter in the Model 831
manual.

ISO 1996-2: enables 1996-2 Annex C tonality
measurements while in FFT mode.

Tone Seek Delta: determines noise pauses in your
measurement, as described in ISO 1996-2 C.4.2. The default
is 1 dB.

For more information on selecting a
regression range, see ISO 1996-2
section C.4.

Regression Range: determines masking noise, as described
in ISO 1996-2 C.4.4.The percentage selected reflects the +
and - range of the critical bandwidth to the right and left of
the center frequency. For example, selecting 75% results in
a range that is 75% to both the left and right of the central
frequency.

Run Mode: this setting determines how a measurement is
terminated and how history records are accumulated. The
three run modes are described below:

• Manual Stop: a measurement begins when the user
presses RUN and ends when the user presses STOP. If
measurement history is enabled, a history record will be
created with each STOP. Each RUN/STOP is considered
a measurement and the overall data will include all
samples from all measurements.

• Count Stop: a measurement begins when the user
presses RUN and ends when the number of discrete FFT
calculations equals the Count setting. If measurement
history is enabled, a history record will be created when
Count is fulfilled. A measurement may be terminated
early by pressing STOP.

• Timed Stop: a measurement begins when the user
presses RUN and continues until the elapsed run time
equals the Time setting. If measurement history is
enabled, a history record will be created each time the
Count setting is reached. A measurement may be
terminated early by pressing STOP.

Count: this setting defines the number of discrete FFT
calculations desired for each measurement and is used for
Count Stop and Timed Stop run modes. This setting is
disabled for Manual Stop run mode. There is a minimum
count value based on the Frequency Span selected as shown
in Table 8-1.
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Table 8-1 Minimum Count

Time: this setting defines the run time desired to complete a
measurement when the run mode is set to Timed Stop. This
setting is disabled for Count Stop and Manual Stop run
modes.

FFT Measurement History: when checked, this setting will
enable the storing of FFT Measurement History records with
each measurement over time.

Range: this setting, in conjunction with the +20 dB Gain
setting, determines the amplitude measurement range of the
FFT as shown in Table 8-2.

+20 dB Gain: this setting, in conjunction with the Range
setting, determines the amplitude measurement range of the
FFT as shown in Table 8-2.

Table 8-2 Range and Gain

Frequency 
Span

Minimum 
Count

20 kHz 20

10 kHz 10

5 kHz 5

2 kHz 2

1 kHz 1

500 Hz 1

200 Hz 1

100 Hz 1

+20 dB Gain Off +20 dB Gain On

Normal 143 dB peak maxi-
mum

123 dB peak maximum

Low 110 dB peak Maxi-
mum

90 dB peak maximum
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Data View

The Data View is displayed whenever a data file is
downloaded from the instrument, Imported from a USB
thumb drive, or a saved data (.slmdl) file is Opened. The
initial display of the Data View will be a Summary of the
first Data Record and is described in Chapter 4 "Data View",
beginning on page 4-1. 

This section will describe the FFT Summary for FFT data as
shown in  FIGURE 8-6.

FIGURE 8-6  Data View: FFT Summary

Please refer to Chapter 4 "Data View" on page 4-1, for a
description of any sections not explicitly described here.
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Settings

The Settings section, shown in  FIGURE 8-7, will display
the active settings used for this measurement.

FIGURE 8-7  FFT Summary: Settings

Overall Broadband Data

The Overall Broadband Data section, shown in  FIGURE 8-
8, will display the broadband Leq, Lmax, Lmin, and Lpeak
values recorded during this measurement. The values will be
weighted according to the frequency weighting setting. The
overload level, count, and duration, for both broadband and
FFT, will also be displayed in this section.

FIGURE 8-8  FFT Summary: Overall Broadband Data
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FFT Graph

To display a graph of the FFT measurement, click the Graph
button on the Data View Toolbar as shown in  FIGURE 8-9.

FIGURE 8-9  Data View Toolbar: Graph

A new window will pop up showing a graphical
representation of the FFT data as shown in  FIGURE 8-10.

FIGURE 8-10  FFT Graph

You can customize the FFT graph by double-clicking it or by
clicking the Graph Properties Customization button and then

Data Legend

Measurement Data
Table

FFT Tonality
Toggle 

Cursor

Graph Display Options

Graph Properties Customization Button
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specifying attributes in the Customize dialog box, as shown
in Figure 8-11.

FIGURE 8-11  Customize Graph

Tonality Data View

To view the tonality data of the FFT measurement, click the
FFT Tonality icon on the toolbar, as shown in Figure 8-12.

FIGURE 8-12  FFT Tonality Icon
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The FFT Tonality dialog box appears, as shown in Figure 8-
13.

FIGURE 8-13  FFT Tonality Dialog Box

In this dialog box, you can alter the settings for viewing the
tonality data. For information on modifying the Tone Seek
Delta or Regression Range, or the FFT settings, see the
"FFT" section in this chapter or refer to the “FFT and
Tonality” chapter in the Model 831 Manual.
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Click OK on the FFT Tonality dialog box to display
tonality data. Figure 8-14 shows the FFT graph with tonality
data.

FIGURE 8-14  FFT Graph with Tonality Data

The tonality data graph displays tone indicators, as shown in
Figure 8-14.

Tone indicators with a critical bandwidth line display tones
that meet the ISO 1996-2 standard. Tone indicators without a
critical bandwidth line represent tones that do not meet the
standard.

Tone Indicator with
Critical Bandwidth Line

Tone Indicator without
Critical Bandwidth Line

Data Set Summary for
Selected Tone

Quality Indicator
Information
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For more information about quality
indicators for Model 831 tonality
assessments, see the “FFT and
Tonality Chapter” in the Model 831
Manual.

When you select a tone, the Data Set displays a summary of
the data associated with the tone. If the tone does not meet
the ISO 1996-2 standards, the quality indicator information,
at the bottom of the Data Set appears.

To select a tone, click on the tone indicator, as shown in
Figure 8-15.

FIGURE 8-15  Selecting A Tone

To zoom into individual tones, select the area on the graph to
be enlarged and drag the cursor to the end of the area, as
shown in Figure 8-16.
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FIGURE 8-16  Zoom Into View Tones

Zooming into tones may be helpful in viewing the noise
regression line, as shown in Figure 8-17.

FIGURE 8-17  Noise Regression Line

Select and drag area to zoom
into one or several tones

Noise Regression Line
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Exporting Data

When exporting FFT data, the Export Data dialog box will
appear as shown in  FIGURE 8-18. Refer to Chapter 5 in this
manual for more information about exporting data.

FIGURE 8-18  Export Data: FFT

When exporting to an Excel Workbook, the FFT data will be
exported to the selected worksheets.
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Summary Worksheet

The Summary worksheet will be created when the Summary
option is checked on the Export Data dialog box. The
Summary worksheet will display the same information as
displayed on the FFT Summary View. Please refer to the
FFT Summary section of this chapter for a complete
description.

Session Log Worksheet

The Session Log worksheet will automatically be created
when the Summary option is checked on the Export Data
dialog box.

FFT Overall Worksheet

The FFT Overall worksheet will be created when the FFT
Overall option is checked on the Export Data dialog box.
This worksheet will display the active settings in effect
when this measurement was taken, followed by the
frequency weighted broadband Leq and Lpeak values and
then the overall average and overall max FFT data for each
frequency bin.

FFT Measurement History (Avg) Worksheet

The FFT Measurement History (Avg) worksheet will be
created when the FFT Measurement History option is
checked on the Export Data dialog box. This worksheet
will display the active settings in effect when this
measurement was taken, followed by the FFT Average
Spectrum table. If using a version of Excel prior to 2010, the
table displays Records across the columns and Frequency
down the rows as shown in  FIGURE 8-19. Due to
limitations in Excel prior to version 2010, the export will be
limited to the first 254 history records. If using Excel 2010
or later, the table displays Frequency across the columns and
Records down the rows as shown in  FIGURE 8-20. This
will allow all data to be displayed.
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The following figure shows a partial
FFT Average Spectrum table for a
measurement.

FIGURE 8-19  FFT Export: FFT Measurement History 
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FIGURE 8-20  FFT Export: FFT Measurement History (Excel 2010)

FFT Measurement History (Max) Worksheet

The FFT Measurement History (Max) worksheet will also
be created when the FFT Measurement History option is
checked on the Export Data dialog. This worksheet is
identical to the FFT Measurement History (Avg) worksheet,
but with the Max data displayed instead of the Average.

FFT Tonality Worksheet

The FFT Tonality worksheet will be created when the FFT
Tonality option is checked on the Export Data dialog box.
This worksheet includes tonality parameter with the FFT
data.
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